
 

 

Printed on 13 October, 2004 

User's Guide 

List Fields 
Version 1.1 

 

Robert Ibsen Voith/Voith's CODE 

 





 

 1 
 

 

This is the User's Guide for List Fields and its main purpose is to unveil 
the possibilities in List Fields and to enable you to make the most out of 
the product. 

 
 

Copyright © 2002-2004: Voith's CODE 
All rights reserved 

Due to continued product development this information may change 
without notice.  The information and intellectual property contained 
herein is confidential between Voith's CODE. and the client and remains 
the exclusive property of Voith's CODE.  If you find any problems in the 
documentation, please report them to us in writing.  Voith's CODE does 
not warrant that this document is error-free. 

No part of this publication may be reproduced, stored in a retrieval 
system, or transmitted in any form or by any means, electronic, 
mechanical, photocopying, recording or otherwise without the prior 
written permission of Voith's CODE. 

Microsoft Word, Microsoft Office, Windows®, Window 95™, Window 
98™, Windows NT®, Windows 2000, Windows XP and MS-DOS™ are 
trademarks of the Microsoft Corporation. 

Xalan, Xerces are trademarks of the Apache.org organization. 

 

Voith's CODE 
Granittveien 13 
N-3140 Borgheim 
Norway 
+47 33 38 77 01 
Internet E-Mail: support@vcode.no 
Website: http://www.vcode.no 
 

Welcome to List Fields 





 

 i 
 

Contents 

Welcome to List Fields 1 

Introduction 1 
What is List Fields ? ...............................................................................................................................2 
History - what was NNTEDIFF ? ............................................................................................................4 
Typographical Conventions.....................................................................................................................5 

Installation 7 
Requirements..........................................................................................................................................9 
Two methods, the installer or manual ....................................................................................................11 

The Installer...............................................................................................................................13 
How to do a manual installation..................................................................................................33 

Security ................................................................................................................................................41 

List Fields Operation 43 
Starting List Fields................................................................................................................................45 

How to start List Fields ?............................................................................................................45 
What happen when you start List Fields ? ...................................................................................48 

Common features - available everywhere ..............................................................................................61 
Copy to clipboard.......................................................................................................................62 
High Quality Rendering of richtext.............................................................................................64 
Follow the links - or - save and open files and OLE objects.........................................................65 

The Main Screen...................................................................................................................................67 
Menus, Toolbars and other Stuff! ...............................................................................................69 

The Field List Area...............................................................................................................................81 
Select Visible Columns ..............................................................................................................82 
Sort any column in any direction - even multiple columns at the same time.................................86 
Reorder columns in any order.....................................................................................................88 
Filter any column to show only what you want ...........................................................................89 
Group on any column.................................................................................................................92 
Show this document in Notes .....................................................................................................93 
Add- or delete fields...................................................................................................................93 

The Information Area ...........................................................................................................................97 
All values...................................................................................................................................99 
Change Log .............................................................................................................................100 
Access .....................................................................................................................................104 

The Output Area .................................................................................................................................105 
The Field Content Pane ............................................................................................................107 
The Field Analysis Pane...........................................................................................................109 
Open or save file-, image- and OLE attachments.......................................................................111 

How to edit fields ...............................................................................................................................115 
Change field names..................................................................................................................116 
Change field types....................................................................................................................117 
Change field content ................................................................................................................118 
Change field flags ....................................................................................................................122 
Create new fields......................................................................................................................123 
Delete fields.............................................................................................................................123 



 

ii Contents 
 

The Change Log.......................................................................................................................124 
Preferences Dialog..............................................................................................................................125 

How things work......................................................................................................................127 
How things look.......................................................................................................................133 
Advanced.................................................................................................................................135 

Replication or Save conflicts...............................................................................................................139 
What is replication ?.................................................................................................................140 
What is a Replication Conflict ? ...............................................................................................141 
How to manually resolve replication conflicts...........................................................................142 
What is the "Save" part in Replication or Save conflict ?...........................................................143 
How to avoid replication or save conflicts ................................................................................147 

Stopping List Fields............................................................................................................................149 
How to stop List Fields ............................................................................................................149 
Do you want to save your changes............................................................................................149 
List Fields saves all layout changes ..........................................................................................150 

Appendixes.........................................................................................................................................151 
The NotesPeek application .......................................................................................................153 
Solving problems - debugging..................................................................................................155 
Messages .................................................................................................................................165 
MIME and 822 Text.................................................................................................................171 

Index 181 
  



 

 1 
 

This guide will cover how to install and use List Fields.  

In This Chapter 
What is List Fields ? ........................................................2 
History - what was NNTEDIFF ? .....................................4 
Typographical Conventions..............................................5 
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What is List Fields ? 
List Fields is a Lotus Notes-based tool which has these objectives: 

 Be an alternative to Document Properties. You have always been able 
to see fields in Notes document either through the Notes-form or via 
the Document Properties. Not all fields are necessary available or 
visible in the Notes form, so you may need to use the Document 
Properties. However, the Fields-list in the small Document Properties 
are small, and it generally feels to small to navigate in if you have 
many fields. List Fields wants to be an alternative to Document 
Properties. 

 List fields in any Notes document. You will see the fields, types and 
other field information. Up to 10 documents can be open at the same 
time 

 Edit field names-, types, flags and content directly in List Fields in an 
easy, intuitive and powerful way. List Fields supports text, text list, 
number, number list, time/date and time/date field types. 

 Show details of the currently selected database, document and field 
 Show the content of the fields, including rich text content such as 

fonts, decorations, inline images, tables etc.  
 Show the fields in a table, which you control completely. You can 

locate, sort, order and group fields to your own preferences.  
 If field content is different between documents, List Fields will easily 

identify these fields with a different row color. This makes it really 
easy to spot which fields differs between documents! 

 Aid you in resolving so-called replication or save conflicts. When 
you open a document which is a part of a replication or save conflict, 
List Fields will detect this and offer you to open the other participants 
as well. This makes it real easy to spot the differences between the 
conflict-participants. You can also open the Notes documents 
themselves from within List Fields.  
Finally you can let List Fields resolve the conflict for you! 

 Show additional descriptive information about known $Fields. When 
you encounter fields such as $Mailer, $UpdatedBy, $MsgTrackFlags 
and so forth, you will instantly know the purpose of these fields. 

 Launch List Fields from either view- or document context. This is 
achieved by enabling the tool as a so-called Lotus Notes-menu addin. 
This makes List Fields available through the Actions-menu in the 
Notes client. You can also launch List Fields directly from the 
operating system, via for example an icon, short-cut or system wide 
key combination. 

 Export the field list with information to other formats such as XML 
or Excel. 

 Copy the content to the clipboard. Both text and HTML format 
supported! 
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 Easily save or open images and attachments from your documents, 
including Notes own internal bitmaps, GIF and JPEG. 

 Easily save or open OLE attachments from your documents. 
 Open Notes documents containing MIME, and see each component 

of the MIME message. This includes the ability to open HTML parts 
and save and open image elements! 

 Use a modern user interface, which let you control the position and 
size of every component. You can easily drag and drop the output and 
detail areas to their own windows, or let the be integrated in the user 
interface.  

 Act as a successor to the old NNTEDIFF.DLL tool. Lotus Notes 
release 3 and 4 was shipped with an undocumented tool named 
NNTEDIFF. This tool enabled you to compare two documents. It had 
its issues, but was great for it's limited use.  
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History - what was 
NNTEDIFF ? 

One of the objectives of List Fields is to be a successor of the old tool 
NNTEDIFF.DLL.This section describe what NNTEDIFF was. 

First we take a look at the built-in field-list allready in Lotus Notes called 
Document Properties. Document Properties are easily accessible by right-
clicking on a document either from a view or from a document. You see 
the document properties below; 

 

The Document Properties are presented in a little dialog box, and you can 
see all kinds of information here. It is generally very handy, and easy to 
use. One of the major disadvantages with Document Properties is the 
fixed size of the dialog box. You can't resize the dialog box so you have 
to do a lot of scrolling both to locate the fields and to see the contents. 
Finally you can't really manipulate the content other than copy it to the 
clipboard. 

With Document Properties available, would you ever need any other tool 
? Many people say yes! What if you want to compare fields from multiple 
document, for example in order to resolve a replication or save conflict ? 
Then Document Properties gets cumbersome to use. 

Back in the Lotus Notes release 3 and 4 timeframe, Lotus shipped an 
undocumented tool called NNTEDIFF. It was shipped as a Dynamic Link 
Library (DLL) and you had to install it manually in the Notes 
configuration file NOTES.INI. When installed, it was accessible through 
the Actions-menu in the Notes client as Compare two documents. When 
you selected two documents from any view in Notes, you would get the 
following dialog box: 

Figure 1: The document 
properties 
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Within the dialog box above you could easily spot which field that 
differed between the two documents. You could also see the content of 
the two fields.  

Easy objective and easy usage! However, NNTEDIFF could also easily 
crash and since it was unsupported by Lotus, you could never count on 
any support. A real "use it if you like it, but don't contact us if you have 
problems"-tool. 

A final challenge was the fact that this tool didn't work at all in Lotus 
Notes release 5 or 6. So NNTEDIFF kind of died with release 4 of Lotus 
Notes. 
 

Typographical 
Conventions 

Before you start using this guide, it is important to understand the terms 
and typographical conventions used in the documentation. 

For more information on specialized terms used in the documentation, see 
the Glossary at the end of this document. 

The following kinds of formatting in the text identify special information. 

Formatting convention Type of Information 
Triangular Bullet( ) Step-by-step procedures. You can follow these 

instructions to complete a specific task. 

Special Bold Items you must select, such as menu options, 
command buttons, or items in a list. 

Emphasis Use to emphasize the importance of a point or for 
variable expressions such as parameters. 

CAPITALS Names of keys on the keyboard. for example, 
SHIFT, CTRL, or ALT. 

Figure 2: NNTEDIFF 
dialogbox 
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KEY+KEY Key combinations for which the user must press and 
hold down one key and then press another, for 
example, CTRL+P, or ALT+F4. 
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This chapter describes how to install List Fields. You will be guided 
through the automatic installer application, in addition to getting the 
nitty-gritty details of which files go where. This will help you install List 
Fields on multiple Lotus Notes installations on one machine. 

In This Chapter 
Requirements...................................................................9 
Two methods, the installer or manual ...............................11 
Security ...........................................................................41 
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Installation 
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Requirements 
List Fields is a Lotus Notes based tool. This implies that List Fields won't 
run as a standalone windows application, but rather as a plugin to Lotus 
Notes. 

When installed, List Fields will reveal itself via the Actions-menu in the 
Lotus Notes client, and it will act on the selected documents in both 
view- and document context. This means that you can start List Fields 
either from a view, where you select from 1 to 10 documents - or - from 
the currently open document, either in read- or edit mode. Finally you 
select the Actions-List Fields menu. 

List Fields has these requirements: 

 Lotus Notes Release 5.0.3 or newer 
 A Notes configuration file (Notes.ini) must be available in the 

first 128 bytes of the system PATH environment variable 
 Machine and platform requirements; The same as for the Lotus Notes 

Release 5 client, which is: 
 Windows 95, 98 or ME - Windows NT 4.x SP3, Windows 2000 

or Windows XP 

 Pentium processor 

 RAM: On Windows 9x and Windows NT more than 32 MB. On 
Windows 2000 more than 64 MB and on Windows XP more than 
128 MB. 

 Diskspace: List Fields occupies approximately 14 MB. If you wonder 
why List Fields occupies all this space, it's because it include a large 
toolkit called Xalan from Apache.org. The Xalan toolkit is used to 
convert richtext in Notes documents to HTML display in List Fields. 
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Two methods, the 
installer or manual 
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The Installer 
A step-by-step guide through the standard installer. 

Why use the installer ? The main benefit by using the installer, is that it 
does the lot for you. It analyses the Lotus Notes installation to figure out 
where you have the Notes program- and data directories, it places all the 
files and components of List Fields in the correct directories, register 
common components and finally update your Registry database with the 
correct settings. Using the installer, should be easy and straight forward. 
In addition, by using the installer, you will also get an uninstaller, so you 
can get rid of List Fields.  
 

The initial installation screen 

When you first start the installer, you'll see this screen: 

 

Note that you can see what release you are about to install already here! 
 

Figure 3: Initial installer 
screen 
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You're not an Administrator ?!? 

In order to install List Fields you need to have so-called administrators 
rights in order to do so. If you haven't got such rights, you will see this 
screen: 

 

When you log on to a computer, your user name and password grant you 
access to the computer. In modern operating systems like Windows 2000 
and XP it is possible to control what a user can- and can't do. This is done 
through so-called access rights. You have different levels of access 
rights, and at the top - with god-like powers, throne the Administrator. 
Anybody with so-called administrators rights can do anything on the 
computer. Other levels, such as the User-level, can't do nearly as much 
on the computer, other that just use it and the installed programs.  

In order to install List Fields you need to create directories, access and 
write to the registry and write files in restricted areas etc. To do all this, 
you need administrators rights. Later, in order to use List Fields, you only 
need Users rights.  

If you see the screen above, then the installer has determined that your 
current user name hasn't got sufficient access rights. You can do one of 
these options: 

1 Log off the current session, and login again with another user name - 
with higher rights.  

Figure 4: Not an 
Administrator ? 
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2 If you are on a Windows 2000 or XP computer, and happen to know 
the user name and password of the administrator account, you can run 
the installer program via the Run As ... option in the explorer. Hold 
the SHIFT key down while you right-click on the installer program 
icon, and you should see an extra menu "Run as...".  
 
Below you see how the Run As dialog box look at Windows XP 
 
 

 
 
 
Note that you can specify another user name and password. If you use 
the administrator user name and password, you will run the installer 
with the rights of the administrator instead of your own. Nifty detail 
in Windows 2000/XP ! 

 

In Windows 95, 98 or ME you always have Administrator rights, and can 
do anything - also installing applications. 
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Install for all users - or just the current one 

The following screen.... 

 

... let you decide whether all users - or - just the current one - should be 
able to use List Fields. This question is targeted at those users that have to 
share a computer with other users.  

If you select Install for all users, List Fields will be available to all users, 
and if you select Install for current user only, only the current user will 
be able to use List Fields. Even if other users may see the application 
files, they will not be able to run the application. 

Behind the scenes this selection determine where some of the necessary 
registry keys should be placed. The all users option place the registry 
data at the so-called HKEY_LOCAL_MACHINE level, and thus makes 
the keys readable to all users. The current user option place the registry 
data at the HKEY_CURRENT_USER level, and thus ensure that only the 
current user has the correct setup for List Fields to run. 
 
In Windows 2000 and XP the stronger security of the registry database 
ensure the security of the settings. In Windows 95, 98 and ME, the values 
will be readable to all users, and thus it may be possible to recreate the 
settings for unintended users.  
 
Therefore, you should not regard this option as a real security measure. 
 

Figure 5: Install for all- 
or current user only ? 
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Lotus Notes is not installed ? 

If you try to install List Fields and it determine that Lotus Notes hasn't 
been installed, you will see this screen: 

 

There are several ways to determine if Lotus Notes is installed or not. 
List Fields look for certain registration keys in the registry. If the 
following key doesn't exist, or hasn't got a value ... 

HKEY_LOCAL_MACHINE\SOFTWARE\Lotus\Notes\Path 

...the installer decide that Lotus Notes hasn't been installed correctly. All 
versions of Lotus Notes 5 and 6 sets this value if you install Lotus Notes 
with the standard installer from Lotus/IBM. 

Multiple versions of Notes installed on the same machine ? 
 
If you have multiple versions of Lotus Notes installed on the same 
machine (you are a Notes developer for example), the registry value 
above will contain the path to the latest Notes installation you performed. 
So if you installed Notes R5 and then Notes 6, the registry keys will 
contain the values of Notes 6, since that was installed last.  
 
If you need List Fields to work on both versions, please refer to this topic 
to see how to do the install manually. The installer does not support 
multiple Notes installations at this time. 

 
 

Figure 6: Lotus Notes 
isn't installed 
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The Licence 

Now it's time for some licence-reading. The screen looks like this: 

 

Read the licence and either agree to it - or not. If you don't agree to the 
licence, the installation will abort. You will also have the possibility to 
read the licence when the installation has finished. The Installation 
Completed! screen in the installer has a View Licence button.  

Note: The licence contains - among other legal material - information 
about how List Fields may - or - will communicate over internet. 
 

Figure 7: The Licence 



 

 Installation 19 
 

Simple or Advanced Display ? 

When List Fields start up for the first, initial time, you will be presented a 
simple or advanced layout. You select what option you want in this 
screen: 

  

To help you differentiate between these two options, take a look at the 
simple display layout below: 
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Basically you see a table with the fields and their content. Pretty easy and 
not too much clutter on the screen. This is therefore the simple display. 

Below you see an Advanced Display screen: 

 

Oops! Much more clutter on the screen! Well that's the Advanced Display 
! The blue square now contains the field list as you know from the simple 
display. In addition you have got other elements. The green square 
represent the so-called Information Area, which shows details about the 
currently selected database, document and field. The red square represent 
the so-called Output Area which shows the content of the currently 
selected field. In the sample above, you see how List Fields explain the 
content of the special Notes field $Fonts. 

Note that you can change the visibility (see an area or not), and position 
and size of it at any time. This option during installation is only to give 
you a smooth start! 

Also note that you can revert back to original layout at any time from the 
Field Area Preferences dialog box (see "Field List Area Preferences" on 
page 134). 
 

Figure 8: Simple Initial 
Display 

Figure 9: Advanced 
Initial Display 
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Additional Information 

Voith's CODE want to be as honest and clear about what the installer to 
as possible. Therefore you will see this screen informing you about the 
prerequisites and content: 

 

Read information and press Next. 

Why this honesty ?  
 
The world is full of software installing spy-ware, ad-ware and other 
behind the scenes logic without you knowing it. Often software 
communicate over the internet, sending and revealing information about 
your computer, installed software and usage patterns, again without 
informing you. 
 
Voith's CODE want to contribute to an open - "we ask before we do"-
policy believing that you, our customer, should stay in control over your 
computer and software, and decide yourself what should be 
communicated or not. 
 

Figure 10: Additional 
Information 
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Select Installation Path 

Now it's time to decide in what directory you want to install List Fields. 
This is done from this screen: 

 

The List Fields-installer suggest a traditional directory located in the 
Program Files directory on your computer. Change this to your own 
personal standard if you like - such as omitting the company name if you 
want a directory sorted on the program name. 

You can press the Change button to change the directory. 

Also note the size of the installation, and how much available space you 
have on your selected harddisk.  

Figure 11: Select 
Installation Path 
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A note on the size of this application 
 
- What ?!? 14+ MB for this simple little tool!!! .... The application itself 
is around 4 MB due to the fact that the application use so-called static 
linking in order to reduce dependency of common DLLs on your 
computer. If List Fields used the opposite linking scheme, so-called 
dynamic linking, the application would be approximately 1.5 MB. The 
online help file itself is 1.6 MB. Lotus own API toolkits occupy 
approximately 3.5 MB.  
 
In order to perform good quality output from richtext fields, List Fields 
carries the Xalan XSLT processor from Apache.org. This is a pretty big 
library occupying approximately 4 MB. Future releases of List Fields 
may change these libraries, and thus shrink on filesize. 
 
Sorry for any inconvenience this need for diskspace demand on your 
computer! 

 
 

Select Shortcut Path 

You set the so-called Shortcut Path here: 

 

This is the folder where List Fields will appear under your Start -> All 
Programs menu. Use the drop down arrow to select any existing folder, or 
enter a new one. 
 

Figure 12: Select 
Shortcut Path 
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Lotus Notes is running 

Since List Fields is a Lotus Notes-based tool, it need to make Lotus Notes 
aware of its presence. This is mainly done via one key and value in the 
main configuration file of Lotus Notes; NOTES.INI. This change can be 
done without stopping Lotus Notes on it's own, but, if you run a previous 
version of List Fields, a component of List Fields will be loaded in 
memory by Lotus Notes at startup, and thus held by Lotus Notes. This 
means that the installer can't re-install the file, since it's already "active". 
Below you see how such as message would look: 

 

The only remedy is to stop Lotus Notes first. In addition, even if the 
installer where able to replace files during the install process, Lotus Notes 
would have to restart in order to show you the menu item for List Fields. 
So, you're in for a restart of List Fields almost anyway! 

If Lotus Notes is active when you install List Fields, you will see this 
screen: 

 

You can either stop Lotus Notes itself, and click Next, or - you can click 
on the Stop Notes button. The Stop Notes button will try to close Lotus 
Notes gracefully. You'll see this message: 

Figure 13: The file is 
active 

Figure 14: Lotus Notes is 
running 
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However, if you have any documents that need attention in Notes, where 
dialog boxes such as "Do you want to save this document" popup, this 
close-command will fail.  

You should to check that Lotus Notes really stopped before you continue. 
 

Figure 15: Stop Lotus 
Notes Warning 
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Info about Lotus Notes/List Fields integration 

This screen inform you about how List Fields integrate with Lotus Notes: 

 

Lotus Notes separate raw data from look and feel by the concept of back-
end and front-end data. Read much more about that here.  Lotus Notes 
offers several ways to integrate with applications, especially if you just 
want to access Notes back-end data. When it comes to integration with 
the front-end the possibilities are limited.  

Basically to you have Notes Menu Addins and Import Libraries.  

Import Libraries are ment to import data into Notes documents. Lotus 
Notes have several import libraries for files such as Microsoft Word, 
Microsoft Excel etc. You find all these libraries in the drop down list on 
the dialog box originating from the File->Import menu. Import Libraries 
are not suitable for the kind of integration List Fields wish to perform. 

The other possibility is Notes Menu Addins. List Fields installs itself as a 
menu addin, and List Fields will reveal itself from the Actions menu in 
Lotus Notes. It looks like this: 

 

Figure 16: Info about 
Lotus Notes/List Fields 
integration 

Figure 17: The List 
Fields menu 
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A menu addin is installed in Notes by registering it's DLL name in the 
keyword AddInMenus in the Notes main configuration file NOTES.INI. 

When you press Next, the installer will search and find all NOTES.INI 
files in the common Notes program- and data directories, and modify the 
AddInMenus keyword. 
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Ready to Install 

Finally, you are ready to install! You'll see this confirmation screen: 

 

This is the final chance to abort the installation without spreading files all 
over the place! Beyond this point, you must use the uninstaller to remove 
List Fields. Press Next to continue. 

If you continue, you'll see the installer perform work, and that we be 
shown in this progress screen: 

 

Figure 18: Ready to 
Install 
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Installation Completed! 

When all files have been copied and all configuration done, you'll see this 
screen: 

 

After a sincere THANK YOU, you can press the Finish button to finish 
the installation. This will terminate the installer successfully. 

You also have the possibility to view the licence again, if you want to. 
 

Figure 19: Installation in 
Progress 

Figure 20: Installation 
Completed 
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What - do I need to reboot ? 

You will only see this screen if you are installing List Fields on Windows 
95, 98 or ME. All other Windows operating systems "survive" the 
installation without rebooting. 

The screen looks like this: 

 

The installer will change the AUTOEXEC.BAT to include a path to the 
installation directory. All applications based on any Notes APIs demand 
this. You must reboot your machine in order to activate the changes. 
 

Figure 21: Need to 
Reboot 
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Uninstalling List Fields 

All good things come to an end, and you might end up saying "No, List 
Fields was not for me". 

As a good citizen of the Windows community, List Fields therefore offers 
an uninstaller. An uninstaller is a little program that removes List Fields 
gracefully from the machine. Remember, the installer copies several files 
to different directories, and do numerous changes to the registry database, 
and even if it is fully possible to remove List Fields manually, it's not 
recommended. The uninstaller does this job for you! 

You can start the uninstaller in one of two ways.  

Via the Control Panel's Add or Remove Programs applet.  

 

After the Add or Remove Programs applet has started, locate Voith's 
CODE List Fields and press the Remove button. 

Figure 22: The Control 
Panel 
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After this operation, List Fields will be gone. Be sure to restart Lotus 
Notes to make the menu disappear. 

The other way to initialize the uninstaller, is to select the Uninstall List 
Fields from the Programs->Voith's CODE->List Fields menu: 

 
 

Figure 23: Remove List 
Fields 

Figure 24: Launch the 
Uninstaller 
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How to do a manual installation 
This topic guide you through a manual install of List Fields. This is 
handy if you have multiple Notes clients installed on the same machine, 
or if you want to automate the installation of List Fields. 
 

Notes Menu Addin tools 

List Fields is a so-called Notes Menu Addin tool. This type of application 
has some general characteristics: 

 The application is visible in Lotus Notes's Actions menu. An example 
is shown below 

 
 It can be activated when certain conditions are met, such as; "Only be 

enabled when document is in edit mode, and that you have placed the 
cursor in a richtext field", or "Only be enabled when user is in a 
view". If the conditions aren't met, the menu item is disabled - or 
grayed out. 

 The application itself must be a DLL with specific functions. Please 
see the Notes C API documentation for specific details. 

 The DLL must be specified in NOTES.INI. Add the DLL filename to 
the AddInMenus keyword. If you don't place the DLL directly in the 
Notes Program Directory, you should specify the full path and 
filename. 
 
Note: The Notes.ini must be available in the first 128 bytes of the 
system environment variable PATH. 

The menu addin applications has several limitations, where the lack of 
document identification mechanism is one of the most severe. To 
overcome such limitations, Notes menu addin applications uses various 
techniques. 
 

Figure 25: The List 
Fields menu 
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The Application Directory 

List Fields installs files in several directories, but the so-called 
Application Directory is regarded as home. Typically this directory is 
placed somewhere along the Program Files directory structure. If you 
installed Windows with default directory structure, you'll find a 
C:\Program Files directory. Typically applications create a company 
subdirectory here, such as Microsoft, Adobe or Macromedia.The installer 
will try with a default company name of Voith's CODE for List Fields. In 
the company subdirectory C:\Program Files\<Name of any company> 
applications typically create an application directory. In our case the full 
application directory will be C:\Program Files\Voith's CODE\List Fields.  
 

The following files are placed here: 

Filename Description Filesize 
VCLFD100.EXE The main application 1.3 MB 

LIST FIELDS USER 
GUIDE.CHM 

The online help file. This can also be displayed 
independently of List Fields 

1.6 MB 

LICENSE.TXT The End User License ("EULA") file, same as shown 
during installation. 

5 kB 

UPDATE.EXE List Fields contains a feature to download updates 
via Internet, and this program file does that job. 

700 kB 

UPDATE.ICO Icon file for the Updater 29 kB 

UPDATE.CLI Data file for the Updater 23 KB 

TIPS.TXT Tips for the "Daily Tips" window. ~ 2 kB 

 
 

Notes Program Directory 

This is the directory where the main Notes files are placed. Search for 
NLNOTES.EXE and you are on the spot! You can also look in the Registry 
for the value of following key: 
HKEY_LOCAL_MACHINE\SOFTWARE\Lotus\Notes\Path. 

If you install Notes R5 in the default directories, the Notes Program 
Directory will be C:\Lotus\Notes. If you do the same with Notes 6, the 
default program directory will be C:\Program Files\Lotus\Notes. 
 
The following files are placed here: 

Filename Description Filesize 
VCLFM100.DLL The Notes Menu Addin DLL. This file is registered 

in NOTES.INI's AddInMenus keyword 
24 kB 
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NDBLF.DLL A Notes Database Driver used to among other things 
identify current context. This is called directly by 
Lotus Notes and Notes won't look in other 
directories! 

57 kB 

LCPPN23.DLL The Lotus Notes C++ Runtime DLL. This is 
necessary when we want to program in C++ and let 
our application access Notes! 

1,8 MB  

DXLTOOLS10.DLL  The Lotus DXL Runtime DLL. This is used to 
extract Notes data into the Lotus'ish XML format 
DXL 

2,6 MB 

VCLFSUPRT.DLL Support DLL for List Fields 700 kB 

 

Very important: In order to have Notes C/C++ API based applications run 
correctly, these applications must know where to find the core Notes 
program files. The C and C++ API libraries use functions in all the 
DLLs! This is done by specifying the Notes Program Directory in the 
PATH environment variable. In Windows 95, 98 and ME, this is set in 
the AUTOEXEC.BAT file with the command  
 
SET PATH=%PATH%;<full path to the Notes Program 
Directory> 
 
In Windows NT, 2000 and XP the PATH environment variable is set 
from the System applet in the Control Panel. Be sure to have 
Administrators Rights in order to change this variable's content. 
 

The Windows System Directory. 

List Fields consist of several component files, that both need to be placed 
in the so-called System directory. This is typically C:\Window\System32 
or C:\WINNT\System32 if you have installed Windows in it's standard 
directories. If you are uncertain what your system directory is, take a look 
at the PATH statement definition. The System directory is very often 
specified there, since this directory contains many many common and 
shared component files. 
 

The following files are placed here: 

Filename Description Filesize 
ACTSKIN43.OCX This is the Skin component, making it possible to use 

different skins in List Fields. This file need to be 
registered - more on that later! 
 
This file needs to be registered in Windows. See how 
to do that here. 

380 kB 

ACTSPLASH.OCX This is the splash screen component. 

This file needs to be registered in Windows. See how 
to do that here. 

190 kB 
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DXDBGRID.DLL This is the grid component, which List Fields use for 
it's field list in the table 
 
This file needs to be registered in Windows. See how 
to do that here. 

665 kB 

DXDBINSP.DLL This is the so-called "Inspector" component, which 
List Fields use to show the database, document and 
field properties in the Information Area 
 
This file needs to be registered in Windows.See how 
to do that here. 

316 kB 

XALAN-
C_1_6_0.DLL 

This is the XSLT processor, from Apache.org 1.9 MB 

XERCES-
C_2_3_0.DLL 

This is the XML processor, also from Apache.org 2.0 MB 

 

All these files are installed as system files by the List Fields-installer, 
which means that Windows keep track of their usage. If other 
applications use the same files, these files won't be uninstalled if you 
choose to uninstall List Fields. This protection only works if you use 
Windows NT, 2000 or XP. 

 
 

Notes Data Directory 

The Notes Data Directory the directory where Lotus Notes place it's 
database files (all the NSF and NTF files among others). It is not used 
during installation 
 

The Temporary Directory 

List Fields creates several files during operation, and it will remove the 
files after normal operation. In the unfortunate situation of a application 
crash, or other malfunction, the temporary files won't be automatically 
removed. No important information is ever stored here, so you can safely 
remove all temporary files! 
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Necessary modifications in the Registry 

The List Fields makes several modifications to the registry.  

Note: Some of the settings are obfuscated, to keep your registration 
information a little bit more secure for prying eyes. This information is at 
the present time not possible to recreate in a manual matter. 
 
Another thing to note; If you select to install List Fields for all users, the 
following keys and values below should be placed in the 
HKEY_LOCAL_MACHINE\Software hierarchy. If you just want to install for 
the current user, place keys and values in the 
HKEY_CURRENT_USER\Software hierarchy. Read much more about that 
here. 

Below you see an image of the registry content: 

 

The Options and Data keys are obfuscated. Below is a table which 
identifies each key and it's value 

Key Value 
Install\Data Obfuscated 

Install\NotesINIs Used by the installer to keep track of which 
NOTES.INI files it has modified with the necessary 
NOTES.INI changes. See more about these changes 
here.  

Install\Options Obfuscated 

Install\Path The full path to where the main application file 
specified in the key Settings\Doer\Module,, see 
below 

Figure 26: The List 
Fields Registry Content 
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Install\PCode Product Code. This is used if you want to upgrade 
the software via Internet. The PCode has the 
following meaning: 
VCLF_R<Release number>_L<Language number>. 
Currently we are on release 1, and the only available 
language is 9 meaning English. VCLF=Voith's 
CODE List Fields by the way! 

Install\Type Installed for all users ? If so "All" is the value, if not, 
the key isn't installed 

Settings\Doer\Module The name of the main application file, the so-called 
"doer". The current value is VCLFD100.EXE.  

Settings\Doer\Title The title of the application 

Settings\Doer\Menu\ 
Messages 

Several messages used by the Notes Menu Addin 
DLL to inform user about potential problems. 

Settings\Doer\Menu\Title The menu item title as it will be shown in the 
Actions menu in Lotus Notes. If you use an 
ampersand (&) this will be the keyboard accelerator 
in the menu. 

Settings\Version The current build-version of List Fields. Note that 
you might stay on release 1.0 for a long time, but the 
build numbers increase as bug fixes etc. are 
implemented. 
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Necessary modifications in the NOTES.INI 

In order to make List Fields, it must be registered as a Notes Menu Addin 
tool. This is primarily done with the AddInMenus keyword in the 
configuration file NOTES.INI.  

Note: Different versions of Lotus Notes have over the time placed 
NOTES.INI in several directories. The best tip is to use the Windows 
Search for files tool and locate your NOTES.INI. This will at the same 
time reveal if you have multiple NOTES.INIs on your machine.If so, it's 
very important to modify the correct one. If you for example have Notes 
R5 and Notes 6 installed simultaneously, you must know which version 
you installed latest, since all Registry modifications done by the Notes 
installer always point to the latest installation.  
 
If you want to use an earlier Notes version, you must also ensure that the 
PATH environment variable also point to the old installation, and not the 
current installation. 
 
The trick is to get List Fields to use the Notes DLL files of the version 
you plan to use List Fields in. List Fields can't operate in two different 
Notes versions simultaneously, . 

Below you see a snippet from a NOTES.INI file with only List Fields's 
Addin menu DLL, and no other previous Notes Menu Addin tools 
registered: 

[Notes] 
... 
AddinMenus=VCLFM100.DLL 
... 

This could also have been specified like this: 

[Notes] 
... 
AddinMenus=C:\Program 
Files\Lotus\Notes\VCLFM100.DLL 
... 

And finally you see how the AddInMenus look like when it has more 
than one Addin Menu. The comma is used as separator between the 
DLL's 

[Notes] 
... 
AddinMenus=VCLFM100.DLL,TANSA2.DLL,NSFINFO.DLL 
... 

The sequence of the DLLs determine the order of the menu items in the 
Actions menu. 
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Register common components 

List Fields contains several common modules which needs to be so-called 
registered in Windows. This means that the components are registered in 
the Registry with it's information, and thus made available to all other 
applications in Windows that would like to use their functions and 
features.  

In order to register functions in Windows, ensure that the files are placed 
in the correct directory. Read more about that here. Then open an 
command prompt (CMD.EXE from the Start->Run ...menu) and locate the 
system directory with the change directory command CHDIR (or CD for 
short). This can be done like this: 

CD \Windows\System32 

When in the system directory, issue the following command: 

REGSVR32 <name of file to register> 

For example: 

REGSVR32 DXDBGRID.DLL 

When enter is pressed, you should after a short while see a confirmation 
message of a successful registration. Do this for all the system files that 
has "This file needs to be registered in Windows" here. 

You may also uninstall - or un-register the component by issuing the -u 
parameter, such as: 

REGSVR32 -u DXDBGRID.DLL 
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Security 
Lotus Notes has always been a very secure place to store data. Nothing - 
repeat - nothing can access Notes data without having a valid user ID file. 
We say we operate in the context of a specific user ID. This implies that 
List Fields will have the same rights as the currently used ID file, and you 
cannot access data you're not authorized to access. 

Lotus Notes normally asks for a password during startup (this feature can 
be turned off, if you have enabled automatic synchronization between 
your Windows user id and Notes. Refer to the installation of Lotus Notes 
for further details). When entered and accepted, Lotus Notes let you 
access all the data that you have access to. 

When you run additional so-called Notes based applications - such as 
List Fields, you will also normally be prompted for a password. It may 
look something similar to this dialog box: 

 

This will happen every time you start the Notes based application.  

Why is it like this ? It has all to do with security of your data. Nothing 
that you don't explicitly allow to access your data, should be able to do so 
behind the scenes. Imagine how trojan- and virus like applications could 
install silently and access your data without you knowing it - that would 
be considered a severe security breach!  

How to make Lotus Notes stop asking for a password all the time ? 

Unfortunately the standard Notes security makes your legal Notes based 
applications cry for password every time they access Notes data. Lotus 
has a feature which allows you to trust all Notes based applications at 
large. 

This feature is controlled within the dialog box of your Notes user ID file, 
and is thus protected by the heavy Notes user ID protection logic of Lotus 
Notes. The procedure to allow Notes based applications access, differs a 
little bit between Lotus Notes Release 5 and Notes 6. 

How to allow Notes based applications access to Notes data in Lotus 
Notes Release 5 

Figure 27: Notes API 
Password dialog 
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Access your user ID dialog box via the menu File -> Tools -> User ID. You 
may have to enter your Notes password. In this dialog box you will see 
the following field on the Basics tab. 

 

When you select Don't prompt for a password from other Notes-based 
programs, you will not be asked for a password. 

How to allow Notes based applications access to Notes data in Lotus 
Notes Release 6 

Access your user ID dialog box via the menu File -> Security -> User 
Security. You may have to enter your Notes password. In this dialog box 
you will see the following field on the Security Basics tab. 

 

When you select Don't prompt for a password from other Notes-based 
programs (reduces security), you will not be asked for a password. 

Things to think about when you do this 
 
Selecting to trust Notes based applications like shown above will trust 
all Notes based applications at large. Either you trust none, or you trust 
all! You cannot select which applications to trust and which you don't 
trust.  
 
This has some security aspects, since it expose your system for 
potentially malicious code. After you select this feature, Notes based 
applications can access your Notes data without you knowing it.  
 
So what to do ? A software vendor (like Voith's CODE...) tells you to 
install a tool (such as List Fields...) and that you must enable the don't 
prompt for password-feature above in order to avoid password popups. 
Make an assessment of the vendor. Is the vendor trustworthy ? Then 
make an assessment of the application. Should the application be 
trusted ? If answers to both questions are yes, then enable don't prompt 
for password, otherwise don't.  
 
But what's more important: You must pay attention to any following 
Notes based applications you may install later. These applications now 
have direct access, since the don't prompt for password-feature already 
has been turned on. 

 

Figure 28: "Don't 
prompt for a password" 
in R5 

Figure 29: "Don't 
prompt for a password" 
in ND6 
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This chapter will guide you through operation of List Fields, and unveil 
the features of List Fields one by one. 

In This Chapter 
Starting List Fields...........................................................45 
Common features - available everywhere .........................61 
The Main Screen..............................................................67 
The Field List Area ..........................................................81 
The Information Area.......................................................97 
The Output Area ..............................................................105 
How to edit fields.............................................................115 
Preferences Dialog ...........................................................125 
Replication or Save conflicts............................................139 
Stopping List Fields .........................................................149 
Appendixes......................................................................151 
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Starting List Fields 
This topic covers how to start List Fields and describe the dialog boxes 
and choices you encounter when you start the application. 
 

How to start List Fields ? 
List Fields can either be started via the Action-menu in the Notes client, or 
directly from the operating system, such as from an icon, short-cut or 
system wide key combination. This gives you maximum flexibility on 
how to start List Fields! 
 

How to start List Fields via the Action menu 

The most feature rich way to start List Fields is from the Actions -> List 
Fields menu in the Lotus Notes client. Before you select this menu, you 
must select at least one document from a view, or have an document open 
in either read- or edit mode. You can thus start List Fields from either 
view- or document context respectively. Below you see how the List 
Fields menu appear at the bottom of the Action menu: 

 

 

 

The placement of the menu is locked by Lotus Notes itself. All so-called 
Lotus Notes menu addins will be placed in the Actions menu in the order 
they appear in the AddInMenus keyword in the Notes configuration file 
NOTES.INI. Notes menu addins will always be placed at the bottom of 
the menu. 

If you don't see the List Fields-menu then List Fields hasn't been installed 
correctly. Please refer to the Installation chapter for further details. 

Note! Launching List Fields via the Actions-menu is the only way to 
open multiple documents at once. 
 

Figure 30: The List 
Fields menu 
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How to start List Fields from the operating system 

List Fields can also be started directly from the operating system. This 
can for example be from an application icon in your Programs menu or 
Quick Launch Taskbar. You can also assign a system wide short-cut key 
combination to the application for super fast access. 

The trick is to add the parameter /STANDALONE as a parameter to the 
executable file VCLFD100.EXE.  

 

In the figure above the /STANDALONE parameter has been added to the 
short-cut's Target. Whenever you launch List Fields from this short-cut, it 
will now try to detect which document you are working on automatically. 

Figure 31: How to add 
the /STANDALONE 
parameter 
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Limitations! Unfortunately List Fields can't read Design-documents from 
the Lotus Domino Designer yet, nor can it operate on documents in the 
Domino Administrator. You will receive error messages E001 (see 
"E001: The Lotus Domino Designer is on top" on page 165) and E002 
(see "E002: The Domino Administrator is on top" on page 165) 
respectively if either the Designer or the Administrator "is on top" over 
the ordinary Notes client. You must therefore ensure that you only launch 
List Fields when you know that the Notes client is on top, otherwise 
unpredictable results may occur. 
 
Likewise, you should try to launch List Fields on "other elements" than 
ordinary documents. Again, unpredictable results occur if you try to 
launch List Fields when the Replicator Page, Welcome page (without 
documents!) or any open dialog box is active. 
 
Finally, List Fields won't be able to understand view-selections when 
launched in this manner. If you want to compare multiple documents, you 
must launch List Fields via the Actions-menu (see "How to start List 
Fields via the Action menu" on page 45). 
 
If you unfortunately launch List Fields under wrong circumstances and 
unpredictable results occur, the List Fields-process might hang. Use 
Windows' task list to kill the List Fields-process directly. Hopefully the 
Notes clients survives this hang, and you can continue to work in Notes 
afterwards. Otherwise, restart the Notes client as well. Sorry for any 
inconvenience! 

 

 
 

How to assign a system wide 
The newer versions of Windows, such as Windows 98 SE, Windows ME, 
Windows 2000 and Windows XP, has the ability to assign a system wide 
shortcut key to any shortcut. The purpose of this feature is to enable ultra-
quick access to most used applications.  

In the previous screenshot, the key combination CTRL + SHIFT + Z is 
assigned to the List Fields-shortcut. By pressing this key combination 
from anywhere, anytime, List Fields will launch! No need to fiddle with 
the mouse to get to the Actions-menu! 

If your version of Windows doesn't support shortcut key combinations 
directly, there exist several tools on the Internet which has similar 
functionality. 
 

Start List Fields in debug mode 

Hold down the SHIFT key while you start List Fields and you will start 
List Fields in so-called debug-mode. Read more about that here. (see 
"Solving problems - debugging" on page 155) 
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Reset windows positions at startup 

Hold down the ALT key while you start List Fields and all windows 
positions will be reset back to initial positions. This is equivalent of 
pressing the Reset windows positions button in the Field List Area 
preferences (on page 134). Also note that all layout files (see "List Fields 
saves all layout changes" on page 150) will be removed. 
 

What happen when you start List Fields ? 
When List Fields is launched, several things happen. Especially the first 
time! Many things are checked, and you will have several messages and 
questions popping up. This topic explain why these messages and 
questions pop up and how to react to them. 

 
 

Don't show me that again! - Common feature for many 
dialog boxes 

Before we did into each message that can occur during startup, let's check 
a common feature to most messages in List Fields. 

For most of the questions in List Fields, you will have the possibility to 
turn off the message for the future.  

For example, when you feel comfortable with the fact that you probably 
should save your documents before launching List Fields, you can - and 
probably should - turn off this message: 

 

Note the Don't show this again at the bottom. 

What if you regret your choice and want to the see the message anyway ? 

List Fields has the possibility to turn on messages again. This is done 
from the Messages preferences dialog box (see "Messages Preferences" 
on page 129). 

 
 

Figure 32: Have you 
saved the Notes 
Document ? 
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Unregistered version 

If you haven't registered List Fields yet, Voith's CODE will grant you a 
60-day trial period, and you will see a dialog box similar to this each time 
you start List Fields: 

 

For each calendar day passing you will see how many days remain of the 
60-day trial period. Pressing OK let List Fields start normally. 

If you are ready to order List Fields, click on the List Fields order page 
link in this dialog box. This will open up the List Fields order page on the 
web in your default internet browser.  

For additional information, click on the List Fields home page link. 

If you have registered List Fields, you will receive an e-mail from Voith's 
CODE with your registration code. The registration code is a long string 
of characters which should be copied to the clipboard, and pasted into the 
dialog box (see "Enter registration information" on page 52) you see 
when you press the Enter registration code-button. 

What! Has the trial period expired ! 

Eventually will the trial period expire and then you will see this dialog 
box: 

Figure 33: Unregistered 
Version 
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If you feel that you need longer time to evaluate List Fields, please don't 
hesitate to contact Voith's CODE for further arrangements.  

You can either press OK to exit List Fields or press Enter registration code 
to enter a registration code. 

Invalid Registration Key 

You may also see this dialog box if you have other issues with the 
registration code: 

 

The reasons for this message to pop up are: 

 The key has been mistyped. If you manually type the long registration 
code in the Registration Information (see "Enter registration 
information" on page 52) dialog box, or for some other reason can't 
create an exact duplicate of the registration code, you will see this 
message. 

Figure 34: Trial period 
has expired 

Figure 35: Invalid 
Registration Key 
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 The key has expired. The licence system in List Fields allows to 
create registration keys that expire after a specified date. This may be 
the reason for this message. You should have received an e-mail from 
Voith's CODE about registration key expiration before you 
experience this message. 

 The key is restricted to run on only one computer. The licence system 
in List Fields also allows to lock a registration code to only one 
computer. This is controlled via the machine id (on page 53) of your 
machine.  

The only available options at this stage is to press OK to exit List Fields 
or to enter a new registration code by pressing the Enter registration code 
button. 
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Enter registration information 

You see this dialog box when you press the Enter registration code-button 
from the Unregistered Version (on page 49) dialog box.  

 

This is the dialog box where you enter, or paste, the registration code 
received in an e-mail from Voith's CODE.  

Ensure that you have selected and copied the registration code to the 
clipboard, and press the Paste-button. When done correctly, it will look 
like this: 

 

Press OK to save the registration code, or press Cancel to abort the 
registration of List Fields. 

When you press OK, you will see this confirmation message: 

Figure 36: Registration 
Information 

Figure 37: Registration 
Information - with code 
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When you press OK in this dialog box, List Fields will terminate, and you 
have to start it again. 
 

Machine ID 
The machine ID is a key which is unique to your machine, and it is based 
on a number of issues on your machine. For example will the operating 
system version and network card etc. be components in this id. If one or 
more of these components change, the machine id will also change. 

The machine id is located in the Registration Information dialog box, and 
looks like this: 

 

Voith's CODE use the machine id to lock the licence for special licences 
types to one machine. In other words, the licence can't be moved from 
one machine to another. If your licence type require usage of the machine 
id, you will be informed about that in the registration code e-mail from 
Voith's CODE. 

 

 
 

Figure 38: Registered 
key confirmation 

Figure 39: Machine ID 
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Edit- or read mode - and - front-end vs. back-end 
documents in Lotus Notes ? 

Edit- or read mode ?!? 

Lotus Notes has two document modes, either read- or edit mode. In read 
mode you can only read the document, and not alter it. In edit mode you 
can also alter and save the document. It is the security mechanisms in 
Lotus Notes that control whether you read- and/or edit the document. 

List Fields can be launched on Notes documents in both modes. As long 
as you has the right to read the document, List Fields can also read it 
(remember, List Fields inherit the exact same access rights as your Notes 
ID file has). 

Front-end versus Back-end document ?!? 

Another subtile thing to be aware of is the differences between a so-
called front-end document versus the corresponding back-end document. 

When you read or edit a Notes document, you typically do this via a 
Notes form. The Notes form contain the fields and layout of the 
document you see. You have probably seen that you easily can switch 
forms and thus look at the document with different forms. The Notes 
form represent the front-end document and is in fact a copy of the real 
data stored elsewhere. The real data - or back-end document - is not 
stored with the the layout and looks, but separated as more traditional 
data records.  

When you make changes to a Notes document in a Notes form, these 
changes only exist in the front-end document - until you save the 
document. Then Lotus Notes copies the the data from the front-end 
document to the corresponding back-end document. 

This is nice when you want to present a document with different looks 
and features, and makes it easy to change the look and feel of the 
database without changing the real data. It's also cool to know that Lotus 
Notes has done this since it's first incarnation back in 1989 and thus 
making Lotus Notes one of the first database systems to separate display 
from content. 

What if the document is in edit mode and hasn't been saved ? 

List Fields can only access the back-end document! This implies that a 
potential challenge may arise if you launch List Fields on a document in 
edit mode which haven't been saved immediately before List Fields-
launch. List Fields will read the back-end document and show those 
values to you, and you might not see the most current values! Due to this 
fact, you will see the following message if you launch List Fields on a 
document in edit-mode: 
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This message briefly explain the issues presented in this topic, and you 
can easily turn off the message by selecting Don't show this again-
checkbox. If you want to turn the message back on, go to the Messages 
preferences dialog box (see "Messages Preferences" on page 129). 

 
 

Figure 40: Have you 
saved the Notes 
Document ? 
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How do you want List Fields to treat security and access to 
Lotus Notes ? 

When you start List Fields, the first dialog box you'll see will be this one: 

 

From this dialog you select how List Fields should treat password logic. 
The dialog box has two distinct areas. The topmost area contain the 
important password information, very similar to this section. The area at 
the bottom contain the selection area where you finally select how you 
want List Fields to behave. 

As described in the Security (on page 41) section, List Fields cannot 
access Lotus Notes without a valid user ID. That section also describes 
that you have a possibility to trust all Notes based applications at large. 
This will however impose a security risk, that you might not want to 
accept.  

List Fields can therefore work with Lotus Notes security in other ways. 

1 Let everything be as it wore without changing anything. This option 
implies that you don't trust any Notes based applications and have not 
enabled the don't prompt for password-feature in the User ID 
preferences dialog box. This option will force List Fields to ask for a 
password every time it starts. This is cumbersome, but secure.  
 
In the context of the password dialog above, this is similar to entering 
the password in the password-field, but not selecting the Remember 
password (not as secure as letting Notes handle Notes addin-tools. 

Figure 41: List Fields 
Password Dialogbox 
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2 Trust all Notes based applications - including List Fields. This option 
implies that you have enabled the don't prompt for password-feature 
in the User ID Preferences dialog box. List Fields will not prompt for 
a password when it starts, neither will any other Notes based 
application. This is more convenient, but reduces security, since 
every Notes based application now have access to Notes data. This 
option is discussed in detail in the Security section. 
 
In the context of the password dialog above, you should select The 
"don't prompt for a password for other Notes programs" is set in 
User Security settings. This indicates to List Fields that Lotus Notes 
itself won't need to ask for a password for Notes based application 
such as this.  

3 Let List Fields remember the password for you. This option will 
enable List Fields to store your password in encrypted form on your 
machine. When List Fields starts, the password will be decrypted and 
used, thus avoiding Notes asking for a password. This is similar to the 
features you see in for example Internet Explorer when it offers to 
store the password for a certain user ID for you. This option is not 
secure, and is only offered as a convenient way to avoid password 
popups without opening up all security as you do with Option 2. Even 
if the password is stored with strong encryption (AES), it will be 
possible for a knowledgeable cracker to reverse engineer List Fields 
and figure out how the password is stored. Voith's CODE recommend 
that you only use this option if your machine. is installed in a secure 
environment, such as in a locked server room. It is not advisable to 
use this option on a laptop computer. 
 
In the context of the password dialog above, this is similar to entering 
the password in the password-field, and selecting the Remember 
password (not as secure as letting Notes handle Notes addin-tools. 
The sample dialog box above show exactly this scenario. 
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You can also select Don't ask this question again (you can also set this in 
the Preferences). This will hide this password dialog box. If you regret 
this later, you can always turn it back on from the List Fields Preferences. 

What if you enter a wrong password ? 

List Fields will try to use your password, but if that doesn't work, you'll 
see this dialog box: 

 

Retype your password and try again! 
 

Figure 42: Ooops - 
Wrong Password! 
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The Notes document hasn't been saved 

If you try to run List Fields on a document which hasn't been saved yet, 
you will see this message: 

 

The only action is to press OK and abort this List Fields-session. The 
reason for this is that List Fields only can read the back-end document, 
and since the document hasn't been saved, no back-end document exist 
yet. 
 

Backup and work database created 

When List Fields start, it check the existence of the so-called Notes 
Backup Database. This database is a List Fields-created database which 
contains work documents and backups of documents which List Fields 
change. In other words, List Fields won't change a but unless it has a 
complete backup of documents involved. 

If the database doesn't exist, List Fields will inform you about the 
creation of this database, and you will see this message: 

 

The database is created with you (or more precisely, the user ID you run 
Notes in context of) as the only person with access to the database.  
 

Figure 43: The Notes 
document hasn't been 
saved 

Figure 44: Backup and 
work database created 
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Tip of the day 

By default you won't see the "Tip of the day" dialog box. You have to 
enable that from the Preferences dialog box. Read more about that here 
(see "Startup Preferences" on page 128). When enabled, you will see this 
dialog box: 

 

It typically contains small tips about List Fields. If you don't read 
manuals, turn this dialog box on to learn new features.  

If you feel impatient, you can also browse to the next tip, and don't wait 
until next launch of List Fields! 

To turn the dialog box off, un-select Show tips at startup. 
 

Figure 45: Tip of the Day 
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Replication or Save Conflict detected 

If one or more of the documents you have selected participate in a 
replication or save conflict, you will see the following dialog box: 

 

To see what this dialog box do, see this (on page 144) topic, or read more 
about replication and save conflicts in general, see this (see "Replication 
or Save conflicts" on page 139) topic. 
 

Common features - 
available everywhere 

Several features can be used all over in List Fields. You can for example 
copy most information to the clipboard, and use hyper links. 
 

Figure 46: Replication- 
or save conflict detected 
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Copy to clipboard 
Sometimes you would like to use- or take a look at data from List Fields 
in other applications. List Fields can copy most of it's data to the 
clipboard.  

Copy plain text from Field List- and Information Area 

If you are in the Field List- or Information Area, you can just select any 
text and right-click. From the popup context menu, select Copy. 

 

In the screenshot above, some text was selected, and then the right mouse 
button was clicked. Select Copy. 

Copy the whole Information Area as both text and HTML 

In the Information area, you also have the option of copying the whole 
information to the clipboard. Point your cursor at one of the keywords, 
and right-click. 

 

 

This operation will copy the complete Information Area to the clipboard 
both as text and as HTML. 

Copy the whole Output Area as both text and HTML 

From the The Output AreaOutput Area, you use the same trick as for the 
Information Area. Point anywhere and right-click: 

Figure 47: Copy text 
from field list- or 
information areas 

Figure 48: Copy the 
whole Information Area 
to the clipboard 
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Again, both text and HTML formats will be copied to the clipboard. 
 

Figure 49: Copy the 
whole Output Area to the 
clipboard 
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High Quality Rendering of richtext 
List Fields support so-called High Quality Rendering (HQR) of all 
richtext in Lotus Notes. This means that List Fields will attempt to give 
you an idea what the richtext content look like in the real Notes 
document.  

To support HQR List Fields use a mixture of common richtext 
programming combined with DXL processing. Below you see a sample 
of HQR: 

 

1 Most inline images are rendered. GIF, JPEG and Notes own internal 
bitmaps are shown. Click on an image to display a menu where you 
can open- or save the image! Read more about that here (see "Open 
or save file-, image- and OLE attachments" on page 111). 

2 Font and font sizes are shown. Note on font sizes that HTML font-
sizes use size-steps from 1 to 7. This means that the font sizes may 
look smaller or larger than the real font size in the Notes document.  
 
Most fonts decorations such as nold, italics, underlined.  

3 Bulleted lists are shown, also with indents 

4 Numbered lists are shown, also with indents 

Figure 50: Example of 
High Quality Rendering 
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5 Tables are shown, with many of the original attributes such as 
background colors etc. 

It is important to remember that List Fields aim at giving you an idea of 
the richtext content, not a 100% representation! 

Below you see a not-so-successful result of HQR: 

 

The screenshot above is from a newsletter, originally sent as a MIME 
message (see "MIME and 822 Text" on page 171). However, List Fields 
was opened in easy-mode (see "List Fields - in easy-mode" on page 176) 
and thus the Notes API hides a lot of the MIME-stuff and convert the 
MIME parts to richtext automatically. The result is not good looking and 
lack images as well.  
 

Follow the links - or - save and open files and OLE objects 
Many places in List Fields will you see links, which do various things. 
Hover the cursor for a little while over a link, and you should see a little 
tooltip informing you what's about to happen if you click on the link. 

For example, most file attachments, OLE objects and graphics can be 
saved and opened. Read more about that here (see "Open or save file-, 
image- and OLE attachments" on page 111). 
 

Figure 51: Example of a 
not-so-successful Hight 
Quality Rendering 
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The Main Screen 
When List Fields has been launched and you have answered the questions 
about security and if you have saved your Notes document, you will see 
the main screen: 

 

The screen above has all areas enabled. More on those in a second! You 
see that List Fields looks like a traditional Windows application with 
menus, toolbars and other traditional Windows application stuff. Read 
more about Menus, Toolbars and other stuff here. 

First and foremost you see the the Field List Area. 

Figure 52: The Main 
Screen - Advanced view 
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. 

It's main purpose is to list fields and show their fieldtype and content. The 
list can sorted, rearranged and grouped in many ways.  

The next area is the Information Area:  
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The purpose of the Information Area is to show details about the 
currently selected Notes database, document and field. Since List Fields 
has the possibility open more than one document simultaneously, this 
area can be nice to consult to see real details about the currently selected 
field.  

Note that you also can launch other tools from this area. In the screen 
above we can launch NotesPeek which then will start with the currently 
selected database and document. 

The final area is the Output Area: 

 

The purpose of the Output Area is to display the content of the currently 
selected field. List Fields will also show additional nice to know-
information, if the fieldname is a typically used Notes fieldname. In the 
screen above you see information about the field $Fonts.  

The next topics dive into each of these areas. 

List Fields will either show the data directly - or - an interpretation of the 
internal content for you, such as for the internal font-table in the field 
$Fonts. 

Finally, the output area also show the Field Analysis area (see "The Field 
Analysis Pane" on page 109), where field content may be compared 
between documents if you have selected more than one document. 

 
 

Menus, Toolbars and other Stuff! 
List Fields is a traditional Windows application, albeit started from with 
Lotus Notes. However, List Fields has many powerful features, such as: 

1 Move List Fields around and it will start in the same position at 
successive starts. 

2 Resize List Fields with the tiny gripper in the lower right hand corner. 
List Fields remembers it's new size as well. 

Figure 53: The Output 
Area 

Figure 54: The Output 
Area 
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3 The Information- and Output area can be turned on and off at will, 
thus making more room for the essential Field List area. 

4 The Information- and Output areas can be moved, resized and 
dragged outside List Fields! By grabbing the titlebar in these areas, 
you can easily drag the area off the so-called docked position. List 
Fields even remember the position and size of these floating areas. 
You've got the screenspace, we've got the way to fill it! 

5 All menus and toolbars can be moved and placed at any border of List 
Fields. You don't like horizontal toolbars, make them vertical - or - 
even floating. 

All this means that you can tailor the look and feel of List Fields to your 
own taste. 

Below you see a sample on how to change the layout: 

 
 

Figure 55: One way to 
organize the layout 
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The Menu 

 

Menus have been around since the first Windows-like operating systems 
saw the light of dawn. Note that the menus in List Fields are context 
sensitive, meaning that they will react to the place you put your cursor. If 
you can't export data, the File->Export menus will be disabled, or grayed 
out. 

One cool thing about the menu in List Fields is that the menu can be 
moved around! Do you like the menu to floating off List Fields-screen ? 
Grab the little handle at the left hand side of the menu and drag it off the 
List Fields-screen. The menu is now floating, and it will look like this: 

 

The menu can also be attached - or docked - to any of the borders of List 
Fields. When the application starts, it just happen to be docked at the top-
most border. 
 

The File Menu 
The File menu looks like this: 

 

Menu Description 
Print ... Will print the Field List Area content directly. Note that List Fields 

can't print any other area at the moment! 

Print Preview Show you how the printed page(s) will be before you actually print 
them. 

Print Setup. ... Decide how the printer settings should be. 

Export Show the Export sub menu (see "The Export Submenu" on page 73). 
These menus will export the Field List area to various formats 

Exit Terminate List Fields. This can also be done by using the standard 
Windows shortcut ALT+ F4, or by clicking on the Exit button in the 
top-most right corner 

Figure 56: The Main 
Menu 

Figure 57: The Floating 
Menu 

Figure 58: The File 
Menu 
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The Print Setup Dialog 

Below you see how the Print Setup Dialog: 

 

From this dialog you can select which printer to use, and set all it's 
properties.  
 

Figure 59: The Print 
Setup Dialog 
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The Export Submenu 

List Fields support export of the Field List Area to several formats. 
Hopefully you find one you like! The menu looks like this: 

 

You can export to the following formats: 

XML The most versatile data transport format yet! Many 
modern tools support import from XML directly.  

Text Classical but important 

Excel Do you need a spreadsheet to manipulate the Field List 
with ? This export option generates a first class Microsoft 
Excel spreadsheet. 

HTML Generate a HTML page which can be viewed in any 
internet browser 

PDF NOT SUPPORTED YET! Will generate an Adobe Acrobat 
document directly. 

 

Common for all export functions are that you must save the exported data 
to a filename. So if we for example select to export the Field List to a 
XML file, you will see this dialog box: 

 

Figure 60: The Export 
Submenu 
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Select a directory and enter a filename. If you don't supply a filetype 
(such as ,xml in this case), List Fields will provide it for you. 
 

The Edit Menu 
The Edit menu contains traditional Copy'n Paste entries, since you can in 
both the Field List- and Information Areas, select any text and copy it to 
the clipboard. The Edit Menu looks like this: 

 

 

Menu Description 
Undo Undo the last action. Not much used in List Fields 

Cut Will copy the selected content to the clipboard, and delete it from the 
field. Not used in the standard edition of List Fields 

Copy Will copy the selected content to the clipboard. 

Paste Get the content of the clipboard and paste it (ie. type in) where you 
have placed your cursor 

Preferences Open the Preferences (see "Preferences Dialog" on page 125) dialog 
to see or edit the List Fields preferences. 

 

 
 

Figure 61: The Export 
SaveAs dialog 

Figure 62: The Edit 
Menu 
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The View menu contains several options to control what you see. The 
menu looks like this: 

 

Most of the menu items on this menu are so-called toggle menus. This 
means that you can turn on- and off the function behind the menu. You 
will see this indicated by the check mark. In the sample above, almost all 
menu-lines are checked, and thus active! 

 

Menu Description 
Output Area Do you want to see the Output Area ? If you turn off the area by other 

means, such as pressing the little x-icon at the right-hand topmost 
corner of the area, this will also deselect the menu item 

Information Area Do you want to see the Information Area ? 

Standard Toolbar Do you want to see the Standard toolbar (see "The Toolbars" on page 
77) ? 

Export Toolbar Do you want to see the Export Toolbar ? 

Status Bar Do you want to see the Status Bar (see "The Statusbar" on page 76) ? 

Select visible 
columns 

Selecting this menu item, bring up a small dialog, where you can 
select which columns and so-called bands you want to see in the Field 
List Area. Read more about that here (see "Select Visible Columns" 
on page 82). 

 
 

Figure 63: The View 
Menu 
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The Help Menu 
The final menu in List Fields is the Help menu. It looks like this: 

 

The Help Topics bring up this document! 

The About List Fields bring up a dialog which look like this: 

 

In this dialog you'll see some important information about your current 
version of List Fields. In addition you'll see some copyright notices for 
components that List Fields use, such as Xalan and Xerces from 
Apache.org. Finally you'll see some important mail addresses in case you 
want to convey bug-reports or suggestions about List Fields. Voith's 
CODE really appreciate such feedback - good or bad! 

 
 

The Statusbar 

 

List Fields makes use of the statusbar to inform you about menu-selection 
help, progress  of operations, and state of the special keys. 

1 The current build of List Fields 

Figure 64: The Help 
Menu 

Figure 65: The About 
List Fields Dialog 

Figure 66: The Statusbar 
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2 The status information. Lengthy operations will display the progress 
in this area. You can also hover the mouse over a menu to see a short 
help description 

3 The MIME status button. Read more about MIME in the MIME  (see 
"MIME and 822 Text" on page 171)chapter. This button change color 
to indicate the status of the MIME support. In addition you can click 
on the button to see the current status: 
 

 
 
The different colors are: 

1. Gray. The MIME decoding hasn't started yet 

2. Yellow. MIME decoding in progress 

3. Green. MIME decoding finished.  

4. Red. An error occurred during MIME decoding. 

4 The DXL status button. The logic behind this button is equivalent to 
the logic of the MIME button above, but now we monitor the the 
status of DXL processing. 

5 The states of special keys such as CAPS LOCK, NUM LOCK and 
INSERT. 

Finally, note the gripper in the lower right corner: 

 

Grab this with your cursor and drag the List Fields window larger! List 
Fields will automatically remember the new size! 

 
 

The Toolbars 

 

The Toolbars has also been around for a long time. Their main purpose is 
normally to be a quick way to enable and do stuff that you otherwise 
would have use the menus to accomplish. The toolbars are also context 
sensitive, so if you have placed your cursor in an area that don't support a 
toolbar operation, it will be disabled. 

 
 

Figure 67: The Main 
Toolbar 
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Move the toolbar around 
Note that you can use the so-called gripper at the right to drag the toolbar 
to another location. You can even drag the toolbar off the List Fields-
screen, and then we call it a floating toolbar. Below you see a sample of 
the same toolbar floating: 

 

List Fields remember the position of all your toolbars, even if they are 
floating. 

Below you see the same toolbar docked at the left border. 

 

 
 

Figure 68: The Main 
Toolbar Docked 
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Customize the toolbar 
You don't like the content of the toolbar ? Well, remove it, or add new 
icons to the toolbar! The toolbars have a little down-arrow at the end. 
Pressing this array reveal the Customize menu. Press this and you see this 
dialog: 

 

From this dialog, you can select which toolbars that should be visible or 
not. You can even create your new, special toolbars! Also note that you 
can reset all changes back to default. 

By selecting the Commands tab, you'll see the available menus to choose 
from: 

Figure 69: Customize the 
Toolbar 
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From this dialog, you can select menu- and toolbar operations from the 
available commands in List Fields. You select an option in the right hand 
part and just drag it onto your toolbar! List Fields will save your changes 
automatically, and if you regret anything, you can always delete or reset 
the content back to original. 

 
 

Figure 70: Select content 
in toolbars 
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The Field List Area 
The Field List Area is the main area in List Fields. In this table, you will 
see the fields of the documents. Below you see how it looks: 

 

You see that the field list is separated into two main bands (see "Select 
Visible Columns" on page 82), Fields and Documents. The Fields band 
has by default a yellow background, while the Document band has a 
white background. The Fields band contain key information about the 
field, while the Documents-band contain the content of the field in a 
given document. If you look at multiple documents at once in List Fields, 
you will see multiple columns in the Documents-band, with headers like 
Document 01, Document 02 ... Document nn. 

You have the following features in the field list area: 

 Select a field and see information about the field in the Information 
area, and see it's content in the Output area.  

 Sort (see "Sort any column in any direction - even multiple columns 
at the same time" on page 86) any column in any direction 

 Reorder (see "Reorder columns in any order" on page 88) the list, by 
moving the columns 

 Show- or hide columns from the list with Select visible columns (on 
page 82). 

 Filter (see "Filter any column to show only what you want" on page 
89) the list, so see only certain information 

 Group (see "Group on any column" on page 92) the list by any 
column - or multiple columns 

 Print the list 
 Export (see "The Export Submenu" on page 73) the list into text, 

XML, HTML and other formats 
 Change the looks of the field list. The fonts, fontsize, foreground and 

background colors can be changed in the Field List Area Preferences 
(on page 134) dialog box. 

Figure 71: The Field List 
Area 
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You can perform the following actions from the list: 

 Right-click on the Document column Header (such as "Document 01" 
in the screenshot above) to see the context menu for the document. 
You can for example show this document in the Notes client (see 
"Show this document in Notes" on page 93), or you can designate this 
document as the winner in a replication- or save conflict. 

 Right-click on any field to see the context menu where you can add- 
or delete fields. This is only visible if you have author rights to the 
currently selected document. 

 

Select Visible Columns 
Since List Fields contains a list of fields and their values, what is more 
natural than having you control what to see ? The Field List Area shows 
some field attributes, but you can choose more! By selecting the menu 
View->Select visible columns, you will see this dialog: 

  

In this dialog you can select between two tabs, first the Bands, and then 
the Headers. But first some information about bands! 
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What is a band ? 

In the Field List Area you see the columns divided into two main 
columns, where the background of the first is yellow and the background 
of the second is yellow. Below you see this emphasized: 

 

The red square represent the band named Fields, while the blue square 
represent the band Documents. The bands have titles and those band 
names can reordered and removed the same way as you reorder or 
remove individual fields.The important part to remember is that band-
titles are placed above the individual field names, and thus contains one 
or more columns. In the sample above, the band Fields contains the 
columns Fieldname and Type. 
 

How do  you remove a column in the Field List Area ? 

The key is drag and drop! In the first sample we want to remove the 
column Type from the Field List Area. To do this, you follow this 
procedure: 

1 Open the Select Visible Columns dialog from the View menu. This 
show the Customize dialog as shown above. Ensure you select the tab 
Headers. 

2 Point the cursor at the title of the column to remove. 

3 Press and hold down the left mouse key 

4 While holding down the mouse key, drag the column to the 
Customize dialog 

5 Release the mouse key. 

6 You should see that the column is removed from the Field List Area 
and placed in the Customize dialog. 

Figure 72: Field List 
Area - The Bands 
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Below you see a sample of this operation: 

 
 

How do you add a column in the Field List Area ? 

The key is again drag and drop! Follow this procedure to add a column to 
the Field List Area 

1 Open the Select Visible Columns dialog from the View menu. This 
show the Customize dialog as shown above. Ensure you select the tab 
Headers. 

2 In the Headers listbox, point he cursor at the column you want to add. 

3 Press and hold down the left mouse key 

4 While holding down the mouse key, drag the column onto the Field 
List Area. Note that the Field List indicate with two small arrows 
where the column will be placed.  

5 Release the mouse key 

6 You should see that the new column is added to the Field List Area, 
and removed from the Headers listbox in the Customize dialog. 

Figure 73: Field List 
Area - Removing a 
column 
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Below you see a sample where several columns has been added: 

 
 

How to remove or add bands ? 

The logic is completely identical to how to remove and add individual 
columns. Instead do this: 

1 Point cursor and hold down the left mouse key on the band names, 
such as Fields or Documents 

2 Drop the band into the Band listbox - instead of the Header listbox 
and vice versa. 

 

Figure 74: Field List 
Area - Added Columns 
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Sort any column in any direction - even multiple columns at the same 
time 

You can sort any column in the Field List Area just by clicking on it. You 
will instantly see that the content of the field list is sorted according to 
your choice. A small arrow in the column header indicates the sorting 
direction. Below you see a field list sorted descending on the column 
Fieldname. Note the little arrow! 

 

Note that List Fields will try to "hold on to" the current column. When 
you sort the list, you might need to scroll up or down to get to the top or 
bottom of the list. 

 
 

Figure 75: Field list 
sorted descending on 
Fieldname column 
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You can even sort more than one column! 

Hold the SHIFT button down while you click on the column headers to 
sort. Do this on as many columns as you like to create a sorted list 
completely after your taste! 

 

In the screenshot above, we sorted multiple columns starting by pressing 
down the SHIFT  key. While holding down the SHIFT key, we clicked on 
the Type column twice to sort it ascending. And still holding the SHIFT 
key down, we click twice at the Fieldname column to sort that ascending. 
The result is that the Type column is sorted ascending, and the fieldnames 
are also sorted ascending within the Types (Check out $MessageID, 
From, MIME_Version, PostedDate etc.). 

When you combine column sorting with column reordering (see 
"Reorder columns in any order" on page 88), column grouping (see 
"Group on any column" on page 92) and column filtering (see "Filter any 
column to show only what you want" on page 89), you can create almost 
anything 
 

Figure 76: Field list 
sorted on multiple 
columns 
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Reorder columns in any order 
All columns in the Field List Area can also be reordered, meaning that 
you can choose the sequence of columns in the list. You don't want to see 
the fieldname column first ? Well, make it the second column then! 

 

In the screenshot above, the Fieldname column has been reordered as 
column 2 after the Type column.  

You reorder columns by clicking on the column header and while you 
hold the mouse button 1 down, drag it to it's new position. Below you see 
this in action: 

 

Here the Fieldname column is being dragged. When we hover, with the 
mouse button still pressed, at possible positions, you see small green 
arrows indicating the new position if you drop (or, release the mouse 
button) it. 

When you combine column reorder with column sorting (see "Sort any 
column in any direction - even multiple columns at the same time" on 
page 86), column grouping (see "Group on any column" on page 92) and 
column filtering (see "Filter any column to show only what you want" on 
page 89), you can create almost anything 
 

Figure 77: Reordered 
columns in the field list 

Figure 78: Drag a 
column to its new 
position 
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Filter any column to show only what you want 
Every column in List Fields has the ability to filter information. This 
means that you can select a subset of the complete list to narrow down 
the list. For example, you have a field list with many field types, as seen 
below: 

 

Instead of working with the complete list, you can click on the "fat little 
arrow" on the Type column. 

 

Figure 79: Field list with 
many field types 

Figure 80: Access the 
filter for a column 
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You will see a list of available values, starting with (All) and (Custom).  
The rest of the values in this list is automatically created by List Fields 
and contains all unique values for this column.  

If you want to see only the Text fields, click on the "Text"-filter as shown 
above. The result is that the list instantly shows only Text fields: 

 

Note that the "fat little arrow" turned blue, to indicate that a filter is 
active. 

Help, get all my rows back please! 

To revert back to all rows, click the little arrow again and select (All). The 
blue arrow will revert back to black, to indicate that no filter is activated. 

Set filter on multiple columns if you like! 

Activate filters on any visible row to create just the selection you want! 

And finally, set a custom filer ... 

If the filter list, you will always see (All) and (Custom). Pressing 
(Custom), brings up this dialog box: 

 

Figure 81: See only Text 
fields in Field List 

Figure 82: Custom filter 
dialogbox 
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You can set any combination of two filters, and as you see from the 
screenshot above, you can create fairly advanced filters to extract exactly 
what you want! 

When you combine column filtering with column sorting (see "Sort any 
column in any direction - even multiple columns at the same time" on 
page 86), column grouping (see "Group on any column" on page 92) and 
column reordering (see "Reorder columns in any order" on page 88), you 
can create almost anything 
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Group on any column 
One of the cooler things to do in the field list area is to group the list. 
Below is a screenshot showing how the Type-column is beeing dragged to 
the group panel: 

 

Click on the column header and hold the mouse button 1 down to start the 
drag-operation. While holding down the mouse button, drag the column 
up to the group panel. Release the mouse button, and List Fields will 
instantly group the list according to the columns you choose to group on. 
Below is a sample of a field list when we have grouped on the Type 
column. 

 

The list above shows both collapsed and expanded rows.  

Sort the groups! 

Sort the groups just like ordinary column sorting! Just click on the group 
header (Type in the screenshot above) to sort. Each click change the sort 
direction. You can even sort multiple groups in any directions! 

Group more columns! 

The screenshot above shows a list grouped on just one column. You can 
group on as many columns as you like! Just drag the columns up to the 
group panel, and pay attention to the green arrows indicating the position 
in the group panel.  

Reorder any group! 

Figure 83: Drag a 
column to the group 
panel 

Figure 84: A field list 
grouped on the Type 
column 
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If you have grouped a list on more than one column, you can change the 
order of the group-columns just by dragging the group-columns to a new 
position! 

Combination! 

When you combine column grouping with column sorting (see "Sort any 
column in any direction - even multiple columns at the same time" on 
page 86), column reordering (see "Reorder columns in any order" on 
page 88) and column filtering (see "Filter any column to show only what 
you want" on page 89), you can create almost anything! 
 

Show this document in Notes 
You may open any of the selected documents in List Fields in Notes. This 
is especially handy if you have opened several documents in a replication 
or save conflict (on page 144), and don't see the documents directly.  

By right-clicking on the document title ("Document 0x"...), you will see 
the Show this document in Notes menu. 

 

When selected, List Fields will open the selected document in Lotus 
Notes. 
 

Add- or delete fields 
If you have author rights to the selected document, you can right-click on 
any field in the Field List Area, to see the following context menu: 

 

From this menu you may add new fields to the document, or delete the 
selected field from the document.  

To change field name, type, flags or content, you do that by the ordinary 
change (see "How to edit fields" on page 115) methods. 

 

 
 

Figure 85: Show this 
document in Notes 

Figure 86: Field List 
Area Context Menu 
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Add field 

After you select the Add new field menu from the Field List Area context 
menu, you will see this dialog box: 

 

From this dialog box you specify: 

 The field name.  
 The field type 

List Fields will create an field of the specified name- and type with no 
content. Use List Fields's standard editing (see "How to edit fields" on 
page 115) possibilities to fill the field with values. 

As soon as you press OK, a new change log (see "The Change Log" on 
page 124) will be created. The field will only be created when you 
explicitly request to save the active changes in the change log. You 
therefore has the ability to regret this action at any time. 

If you have selected multiple documents, you change will be processed 
on all selected documents. 

Note that List Fields does not verify the data content carefully at this 
stage. You can for example specify that you will create a new number 
field with the content "This is a test". The change will however not 
succeed when you try to save the data.  
 

Figure 87: Add new field 
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Delete field 

After you select the Delete selected field menu from the Field List Area 
context menu, you will see this dialog box: 

 

Confirm that you want to delete the selected field.  

As soon as you press OK, a new change log (see "The Change Log" on 
page 124) entry will be created. The field will only be deleted when you 
explicitly request to save the active changes in the change log. You 
therefore has the ability to regret this action at any time. 

If you have selected multiple documents, you change will be processed 
on all selected documents. 
 

Figure 88: Delete 
selected field 
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The Information Area 
The Information Area is one of the details areas in List Fields. It consist 
of several panes.  

1 All values, see details about database, document and field. 

2 Change Log. This pane contains a record of all changes that will be 
processed when you are explicitly asked. 

3 Access. See your real access to both the database and to the 
documents in List Fields.  
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First of all it will show several details on the currently selected database, 
document and field level. The content of this area will change 
automatically as you select or navigate to other fields in the field list in 
the Field List Area. 

Below you see an screenshot from the All values-pane in the Information 
area: 

 

Hide the Information Area if you don't need it Figure 89: The 
Information Area 
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By clicking the little x-icon at the top right corner of this area, the area 
will hide. You can make it visible again in several ways. You can use the 
menu View -> Information Area to toggle the visibility, or you can access 
the same menu by right clicking anywhere on any toolbar in the 
application. 

.. or move it somewhere else 

Just as many other areas in List Fields, you can also move the area 
"outside" List Fields. Grab the titlebar of the Information Area, and while 
holding mouse button 1 down, drag the Information Area wherever you 
want it. As soon as you start dragging the area, the borders of the area 
will change, indicating the new placement. All features within the area 
works like before, it is just being moved! List Fields will remember the 
layout of all your areas from run till run. 

By double-clicking on the titlebar of the area, you will instantly move the 
area back "within" List Fields. Double-clicking again, will quickly move 
the area out, so the double-click action act as a toggle. 
 

All values 
The All values-pane in the Information Area consist of collapsible and 
expandable sections for database, document and field. Just click on the 
plus or minus sign to expand or collapse each section respectively. List 
Fields will remember your selection from previous runs of the 
application. 

You can also change the position of the divider-line by dragging it to the 
left- or right. 

List Fields aims at making some of the more "hard to get" information in 
Notes databases visible here. In this version you'll find the template 
filename of this database. Normally is this information hidden in the icon-
document of the database, for some strange reason! Again an easy way of 
finding, and making info for the clipboard a snap! 

Copy the content to the clipboard 

You can select any text, such as the database replica id in the screenshot 
above, and copy it to the clipboard. No need to create a dummy Database 
Synopsis just to get the replica ID anymore.  

You can launch NotesPeek from here 

Notice the little NotesPeek icon in this area. By clicking that, you will 
launch the NotesPeek application with the currently selected document 
pre-selected! Check out this topic on how to use this feature! 
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Change Log 
The Change Log-pane in the Information Area contain a list of all 
changes done to any of the selected documents. List Fields does not save 
or modify existing Notes data without explicitly asking you for 
permission to do so. Below you see a screenshot of the change log before 
you have done any changes: 

 

Note the buttons in the toolbar. The buttons are: 

 Save active changes 
 Select all change log entries 

Figure 90: Change log - 
before changes 
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 De-select all change log entries 

As soon as you change anything in List Fields the change log entries will 
be listed here. A change log entry can either be active or non-active, 
meaning that they will be processed or not. Use the Select all or De-select 
all buttons on the toolbar to select- or de-select all entries in one 
operation. Below you see the Change Log with some change log entries 
registered; 

 

Note that you can select and de-select any change log entry. Each entry 
also inform you about the requested change, and in what document or 
documents the change will be processed. This is important to see if you 
have selected multiple documents in List Fields. 

 

 
 

Do you regret changes ? 

The Change Log let you de-select any change log entry so it won't be 
processed when you save the changes. This logic may therefore act as a 
simple undo-system where you can select exactly what to do. 
 

Figure 91: Change Log - 
with some active entries 
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Save you changes 

As you do changes in List Fields, the number of change log entries will 
increase. There are two ways to save your active (ie. selected) change log 
entries: 

 Use the Save button on the toolbar.  
 Wait until you quit List Fields. List Fields will detect that you have 

active change log entries. 

The changes won't be saved until you confirm the following question: 

 

If List Fields has any problems with saving you changes, you will see the 
Save Error Report (see "Save Errors" on page 103). 

Note that List Fields creates backups (see "Backup and work database 
created" on page 59) of the involved documents before making any 
changes!  
 

Figure 92: Do you want 
to save your changes 



 

 List Fields Operation 103 
 

Save Errors 

When you attempt to save your registered field changes, List Fields might 
encounter errors. For example you try to convert an existing text field 
with the content "This is a test" to a number field. The conversion won't 
succeed since "This is a test" can't be converted to a number. 

If the save operation encounter any errors, you will see this dialog box: 

 

Note that List Fields will process all change log entries sequentially, and 
all previous successful changes has been saved. 

 
 

Figure 93: Save Error 
Report 
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Access 
The Access-pane in the Information Area show your real access to both 
the database and all selected documents in List Fields.  

 

Remember that List Fields won't let you change data in documents where 
you haven't requested write access rights. 

List Fields show you the real document access, which is the result of 
looking through all reader- and author fields in the document. 
 

Figure 94: Your Access 
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The Output Area 
The Output Area is one of the main areas in List Fields. It contains two 
different so-called panes, which show: 

 The Field Content, or output of the currently selected field.  
 The Field Analysis of two compared fields, if you have selected more 

than one document - or resolving a replication conflict. 

Below you see a screenshot of how the Output area look: 

 

Hide the Output Area if you don't need it 

By clicking the little x-icon at the top left corner of this area, the area will 
hide. You can make it visible again in several ways. You can use the 
menu View -> Output Area to toggle the visibility, or you can access the 
same menu by right clicking anywhere on any toolbar in the application. 

.. or move it somewhere else 

Just as many other areas in List Fields, you can also move the area 
"outside" List Fields. Grab the titlebar of the Output Area, and while 
holding mouse button 1 down, drag the Output Area wherever you want 
it. As soon as you start dragging the area, the borders of the area will 
change, indicating the new placement. All features within the area works 
like before, it is just being moved! List Fields will remember the layout 
of all your areas from run till run. 

By double-clicking on the titlebar of the area, you will instantly move the 
area back "within" List Fields. Double-clicking again, will quickly move 
the area out, so the double-click action act as a toggle. 

 

 

 

 

Figure 95: The Output 
Area 
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The Field Content Pane 
The Field Content pane shows the content of the currently selected field. 
Below you see a sample of this pane: 

 

As you see in the example above, the field content is not necessarily the 
exact content of the field. The $Fonts-field is a special Notes fields 
containing font information used in the currently selected document. List 
Fields will interpret and explain the content in a more presentable 
fashion. 

Note how you also see some information about the field itself. List Fields 
will display such information if the field is known to be a special or 
reserved field-name in Notes. 

Below you see the Field Content pane when it displays the content of an 
ordinary text field: 

 

The field in the screenshot above wasn't known to List Fields as a 
special- or reserved field in Notes, and then the field info shows No 
current field info.If you disagree that this field isn't a special nor reserved 
field in Notes, you can inform Voith's CODE about this by clicking the 
link. List Fields will then open your preferred  e-mail program with a 
filled in e-mail address to Voith's CODE. 

Rich text fields 

List Fields read richtext information in two stages. The first stage is to 
read the plain text. Until the second stage is finished, only the plain text is 
the available. Below you see a screenshot of a rich text field display: 

 

Figure 96: The Field 
Content Pane 

Figure 97: The Field 
Content pane with an 
ordinary field 
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The second stage, the so-called High Quality Rendering (see "High 
Quality Rendering of richtext" on page 64) (HQR), will show a much 
higher quality of the richtext. 

 

 
 

Figure 98: The Field 
Content Pane with the 
content of a richtext field 
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The Field Analysis Pane 
The Field Analysis Pane will show the comparison between two fields in 
two different documents. If you launch List Fields on an replication 
conflict (see "Replication or Save conflicts" on page 139) document, this 
pane will automatically be displayed. If you launch List Fields on only 
one document, the pane will just contain this information message: 

 

To enable this feature, you must open at least two documents with List 
Fields. Do this by selecting two or more documents from any Notes view 
and launch List Fields. Since the idea of this pane is to compare fields 
with differences, select one of the red-line fields. Below you see a sample 
of this selection: 

 

After selecting the red-lined Body-field, we manually choose the Field 
Analysis pane. Note how the analysis points out where the differences 
between the two fields are. Below you see the Field Analysis area 
zoomed in: 

Figure 99: The Field 
Analysis Pane - Empty 

Figure 100: The Field 
Analysis - comparing two 
fields 
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First of all, note that the pane informs you which documents the field 
belongs to. In the sam,ple above, the Body field belongs to Document 01 
and Document 02.This is important to know if you load more than two 
documents. Remember that List Fields always will compare Document 
01 with whatever document you select in the Field List Area. 

The basic idea of the comparison is to show you what changes have to be 
made if you would make document 02 from document 01 manually. All 
text that is striked out, should be removed, while all yellow text should be 
inserted. In the sample above, you see a couple of typing errors, and 
finally some text (Important speak this is!) that didn't exist in the original 
document at all. 

If the content of the fields are larger than you can see at the screen, you 
can either scroll down by using the vertical scrollbar at the right-hand 
side - or- you can use the First/Next- and Previous difference buttons at the 
right. List Fields will automatically locate the repective change in the text 
for you, so you don't have to wade through pages of text.  

What do I do with this information ? 

In this version of List Fields you can't do much more than spot the 
differences. This may however be useful if you have a replication 
conflict, but doesn't really know why the conflict has arised. 

Future versions may include features to actually resolve the differences 
between the fields in the two documents.  

 

 

 
 

Figure 101: The Field 
Analysis - Comparing 
two fields - Zoomed in 
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Open or save file-, image- and OLE attachments 
If your Notes document contain file-, image or OLE attachments, you 
may open and save these directly from within List Fields! You may even 
be able to open attachments not directly available in Lotus Notes, such as 
if you receive the dreaded More than 64 columns in HTML table error - 
see more on that below. 

The Open- and Save support are available directly in the Output area. 
Click on on any $FILE-field to see details about file attachments. Click on 
the title to see the Open- and Save menu. 

 

In the screenshot above you see the content of a $FILE-field. Click on the 
filename to show the Open and Save context menu. Select the option you 
want to perform. 

Open 

List Fields will automatically detach the file to your temporary file area, 
with a prefix of VCLF_ in the filename. Then List Fields will launch the 
file with your default application for this file extension. If no association 
between the file extension and application exist, you will be informed 
about that in an error message. List Fields will not delete the file after an 
Open operation. 

Save ... 

List Fields will prompt you for a filename: 

Figure 102: The Open 
and Save menu on a file 
attachment 
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The filename from the Notes attachment itself is used as a default 
filename. Choose filename and where to save the attachment and press 
the Save-button. 

List Fields will save the file attachment to the desired location. 

More than 64 columns in HTML table error! 

Have you ever seen this error message in Lotus Notes ? 

 

One way to get this error is if you receive an MIME encoded e-mail with 
a HTML table with more than 64 columns, you will see this error (in 
release 6.0.1 of the Notes client). The e-mail is impossible to open in 
Lotus Notes - but not with List Fields. Just open the document in List 
Fields and click on the $FILE-field, and then open or save the attachment 
as described above! 

Even Open and Save of OLE attachment are supported! 

If you have documents with imbedded OLE objects, such as Word- or 
Excel spreadheets, you normally can't save these objects to files. This is 
actually a limitation in the OLE standard itself, and not in Lotus Notes.  

With List Fields you will have the option to open and save most OLE 
attachments, just as if they were normal file attachments! 

Figure 103: Save File 
Attachment dialogbox 

Figure 104: More than 
64 columns in HTML 
table error 
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Click on any $OLEOBJINFO-fields in a document. You will see an 
Output-area similar to this; 

 

Just as for ordinary file attachments, you can click on the OLE 
attachment name, to see the Open and Save content menu. 

Open 

OLE objects does not know about filenames when they are imbedded, so 
List Fields will create a dummy filename composed on the following 
format: 

VCLF_<OLE Attachment Name> (<FileObjName>).<File 
extension registered to OLE Class on your 
machine> 

The FileObjName in the screenshot above is EXT36302 and is one of 
many internal filename that Lotus Notes assigns to the OLE object during 
imbedding. Finally List Fields determine what file extension the OLE 
Class (Word.Document.8 in the sample above) is associated with. On 
most computers with Microsoft Word or Microsoft Office installed, this 
will be .doc. 

Now that List Fields know the filename, it is saved to your temporary 
directory, and the file is launched with it's default application, just as for 
file attachments. 

If you either don't have a association between the OLE Class and 
application, or file extension and application, you can't open the OLE 
object automatically. But you can try to save it, and use other applications 
to open- and/or convert the file. 

Save 

When you select Save, you will be prompted for a filename; 

Figure 105: The OLE 
Attachment in the Output 
area 
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In the screenshot above, you clearly see the constructed default filename. 
Choose whatever filename and location you want to save your OLE 
object to, and press the Save-button. 
 

Figure 106: Save OLE 
Attachment dialogbox 
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How to edit fields 
List Fields has the ability to edit fields! You can: 

 Change field names. 
 Change field types. 
 Change field content. 
 Create new fields 
 Delete fields 

The editing is done directly in the Field List Area, just by changing- or 
editing directly in the list. If you have selected multiple documents in List 
Fields, the changes might be processed on all selected documents. 

List Fields supports the following field types for editing: 

 Text 
 Text list 
 Number 
 Number list 
 Time/date 
 Time/date lists 

This version of List Fields does not support other field types. 

Note that List Fields honor the Access Control Lists (ACL) for both the 
database and the selected documents. If you don't have proper access to 
the documents, you won't be able to change the data! Check out the Your 
Access (see "Access" on page 104) pane in the Information Area to see 
your real access! 
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Change field names 
Sometimes you realize that a field name should be changed. For example 
you have a Notes database with a Database Script PostDocumentDelete-
event specified. If this LotusScript react on specific form-names, you can 
easily change the form name field with List Fields and thus bypass the 
scripted action in the PostDocumentDelete-event! 

In order to change a field name, just type the new field name directly into 
the field list. List Fields only validates that the field name is valid in 
Lotus Notes (for example max length 32 characters, no spaces etc). You 
may even specify an existing field name, which effectively will lead to 
that the original field with the selected name is replaced by the current 
one! 

If you have selected multiple documents, the field name change will be 
processed on all selected documents. 

As soon as you press Enter, a new change log (see "The Change Log" on 
page 124) entry is created. Remember that List Fields doesn't process any 
changes unless you explicitly ask it to save the changes. 

Press Esc to abort the field name change. 
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Change field types 
Click on the down-arrow in a field type field to see available field types 
to convert to: 

 

Change the field type of a field at any time! List Fields will attempt to 
convert the original content of the field to the new field type. If this 
conversion fails, you will be prompted a detailed Save Errors (on page 
103) report. 

The supported field types are: 

 Text and Text list 
 Number and Number list 
 Time/Date and Time/date list 

If you have selected multiple documents, the field type change will be 
processed on all selected documents. 

As soon as you press Enter, a new change log (see "The Change Log" on 
page 124) entry is created. Remember that List Fields doesn't process any 
changes unless you explicitly ask it to save the changes. 

Press Esc to abort the field type change. 

 
 

Figure 107: Change field 
type 
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Change field content 
List Fields let you change the field content directly within the field list in 
the Field List Area! If the field type of a record is one of the following ... 

 Text 
 Text list 
 Number 
 Number list 
 Time/date 
 Time/date lists 

..you can edit the data directly in the list. You can enter whatever you 
want as new field content and List Fields will attempt to save it as the 
specified field type.  

Important note about editing lists! When you edit lists, note that List 
Fields uses the triple dots (···) as a list separator. If you select to edit the 
values directly in the list-lines, you must copy these dots your self. It is 
much easier to use the built-in list editor (see "The list editor" on page 
120). 
 
No strict field content checking! Note that List Fields doesn't enforce strict 
field content checking. This means that you can enter text in number 
fields, and numbers in date fields. It is eventually up to Lotus Notes 
whether to accept a change or not. If you have save errors, you will see 
the Save Error Report (see "Save Errors" on page 103).  
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The text editor 

To edit plain text, you can either type the text right into the lines in the 
Field List Area, or you can use the built-in text editor. Click on the down-
arrow at the far right of the line, or click CTRL+ENTER to invoke the text 
editor. Below you see a screenshot of the editor: 

 

You can grab the size-gripper at the lower right corner to resize the 
editor. As you see in the sample above, the editor support multiple lines. 
Note that this is not the same as a list or multi-value list field. It is just 
newlines in the data! 

Press OK to accept changes or ESC to abort. If your press OK, and the 
content differ from the existing content, a change log (on page 100) entry 
is created. Remember that List Fields won't save the changes until you 
explicitly confirm to save changes (see "Save you changes" on page 
102). 

 
 

Figure 108: The Text 
Editor 
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The list editor 

Many fields in Lotus Notes documents are so-called multi value fields, or 
simply lists. If you select to edit list data directly in the lines of the Field 
List Area, you must ensure to use the triple dots (···) to separate list items. 
This can easily be erroneous!  

In order to easily edit lists, List Fields has a built-in list editor. By using 
this editor, you can forget about triple dots!  

You access the list editor by clicking on the down-arrow at the far right in 
the field, or press CTRL+ENTER. You will see this dialog box: 

 

If you need a larger list, grab the size-grabber at the lower right corner 
and resize the dialog as large as you want. 

Use the Add or Delete buttons at the toolbar add- or delete items in the 
list.  

The list can be sorted by clicking on the Items-column header.  

To rapidly enter data, you can use the DOWN ARROW to append data to 
the end of the list, or use the INSERT-button to insert rows before the 
currently selected row. 

Press OK to accept changes or ESC to abort. If your press OK, and the 
content differ from the existing content, a change log (on page 100) entry 
is created. Remember that List Fields won't save the changes until you 
explicitly confirm to save changes (see "Save you changes" on page 
102). 
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The calendar editor 

If the field content belongs to a time/date field, you can click on the 
down-arrow at the far right, or press CTRL+ENTER to see the built in 
calendar: 

 

You can use the calendar as an aid to find a correct date.  

Note that the calendar editor doesn't support time-value editing. In the 
sample above, the calendar will only change the date-value (24.02.2004), 
and the time-value (10:19:00) will stay the same when you press ENTER. 
 
The calendar editor can't handle time/date ranges either.You have to edit 
them manually directly in the line! 

 
 

Figure 109: The 
Calendar Editor 
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Change field flags 
Click on the down-arrow at the far right of a flag-column, and you will 
see this dialog box: 

 

All fields has so-called field flags among their attributes. In Lotus Notes, 
these flags control different field behaviour. List Fields let you set or un-
set the following flags: 

 Summary. As you may know, Lotus Notes saves the data separate 
from the presentation. List Fields looks at the document data without 
using a form, and thus looks at the back-end data of the document.  
 
In order to be able to show the document data in views, Lotus Notes 
must copy that data to a special memory buffer, the summary buffer. 
This means that only items that have the Summary-flag set can be 
shown in views. The Summary-flag also controls whether a field can 
be used in @Formulas etc.  
 
Richtext fields cannot have the Summary-flag set, and thus can't be 
shown in views. 
 
You can use this flag to optimize space-usage in databases, if you 
know that a field won't be shown in views or used in formulas. 
 

 Sign. The item is signed 
 Names. The item contain names. Note that Readers and Authors flags 

cannot be set unless you also set the Names flag 

Figure 110: The Flags 
Editor 
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 Readers. The item contain reader names, and thus participate in 
controlling the read-access to the document. You can have multiple 
reader and/or author fields controlling access to a document, and the 
real access to the document is a union of all such fields. You can 
check out your real database- and document access in the Access (on 
page 104)-pane in the Information Area. 
  
The content of a reader-field can be combinations of individual user 
names, server names, group names, and access roles. Remember that 
roles always are enclosed in square brackets, such as [Group Name] 
and that names always must use fully canonical names such as 
CN=Jon Done/O=ACME. 
 
The presence of a Readers-flag implies presence of a Names-flag. 

 Authors. The item contain author names, and thus participate in 
controlling the write-access to the document. Just as for the Readers-
fields, multiple authors-fields may exist, and your real access is 
effectively a union of all author-fields. 
 
The naming rules of the readers-field also apply to authors-fields. 
 
The presence of a Authors-flag implies presence of a Names-flag. 

 
 

 
 

Create new fields 
See Add field (on page 94) 
 

Delete fields 
See Delete field (on page 95) 
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The Change Log 
List Fields will never change Lotus Notes documents without asking you 
explicitly.  

In order to keep that promise, List Fields maintain a change log 
containing every change you do. As soon as you do anything that might 
lead to a change of the original document, the change log pops up 
automatically. For each change you do, List Fields creates at least one so-
called change log entry. For example will List Fields create 1 log entry 
when you add a new field. If you solve a replication conflict, List Fields 
will create several log entries.  

You find the change log as a pane in the Information Area. Read more 
about the Change Log (on page 100) here. 
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Preferences Dialog 
Voith's CODE strive to make List Fields behave the way you want it to!  

Many settings are automatically saved each time you run your 
application, such as position and size of screen elements. Other settings 
are more hidden, and these settings can often be modified through the 
Preferences Dialog: 

 

The Preferences dialog contains several pages. Select a page from the 
items in the list at the left hand side. 
 
See the following topics for the description of each page 
 

Figure 111: Screenshot 
of the Preferences 
dialogbox 
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How things work 
The preferences pages in this section define how different things in List 
Fields work. You can control which dialog boxes to see at startup, hide or 
unhide different messages and control how you want List Fields to update 
itself.  
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Startup Preferences 

 

List Fields will pop up several dialog boxes at startup. You have probably 
already seen both the Unregistered Version (on page 49)- and Lotus 
Notes Password dialog boxes.  

As a user you can select which dialog boxes to see or not, and those 
dialog boxes that support hiding contain a Don't show me this again-
message.  

This Preference page let you control which dialog boxes to see during 
start up. You can control the following: 

 "Tip of the day" (see "Tip of the day" on page 60). Small, practical 
tips each time you start List Fields 

 Splashscreen. Note that the splashscreen can't be turned off in the 
trial version of List Fields.  

 Password dialog box. This is the dialog box where you select how to 
treat Lotus Notes passwords in List Fields.  

 Replication Conflict Information (see "Replication or Save Conflict 
detected" on page 61). This is the dialog box that pop up when you 
run List Fields on a document that participate in a replication conflict. 

Show MIME and 822 Text 

Read much more on what this option do in this (see "MIME and 822 
Text" on page 171) extensive topic. 
 

Figure 112: Screenshot 
of the Preferences 
dialogbox 
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Messages Preferences 

Many messages in List Fields can be turned off, if you feel you don't 
need to see them. The purpose of this is not to annoy you with 
unnecessary messages. 

In order to be able to retrieve the once hidden messages, you can control 
all messages from this preference page: 

 

The messages has been grouped together in Error-, Warning- and 
Debugging messages. 

Error messages: 

 E005 (see "E005: The Notes database can't be opened" on page 166): 
The Notes database can't be opened 

 E006 (see "E006: The Notes document hasn't been saved yet!" on 
page 166): The Notes document hasn't been saved yet 

Warning messages: 

 W001 (see "W001: Have you saved the Notes document ?" on page 
167): Have you saved the Notes document ? 

Figure 113: Preferences 
- How things work - 
Messages 
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 W002 (see "W002: The size of all attachments combined is too large 
for high quality rendering" on page 168): The size of all attachments 
combined is too large for high quality rendering 

 W003 (see "W003: The size of one of the attachments is too large for 
quality rendering" on page 168): The size of one the attachments is 
too large for quality rendering 

 W004 (see "W004: Can't save or open attachments right now!" on 
page 169): Can't save or open attachments right now 

Editing data messages: 

 Q001 (see "Q001: Do you want to save your changes ?" on page 
170): Do you want to save your changes ? 

 Q002 (see "Q002: Do you want to delete the currently selected field 
?" on page 170): Do you want to delete the currently selected field ? 

Debugging messages: 

 I003 (see "I003: List Fields Debug Session database is about to be 
created" on page 169): List Fields Debugging Database about to be 
created 

 I004 (see "I004: List Fields Debug Session database created" on page 
170): List Fields Debugging Database has been created. 
 

To understand what each message mean, please see each message. 
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Update Preferences 

List Fields has the ability to update itself via internet. You can either start 
this feature manually via the menu Help -> On the web -> Check for new 
version, or you can have List Fields automatically check for new updates 
for you. The latter feature is turned off by default. 

 

You control the following options: 

Settings: 

 Automatically check for new versions of List Fields. By enabling this 
option, List Fields will automatically connect to internet and check 
for updated versions of List Fields. It will do so according to the 
Frequency settings below.  
 
You will see the progress of the check in a separate dialog box,and 
can cancel the operation at any time.  
 
If a new version is available, you will be prompted what to do next. 
See below. 
 
If you haven't got a valid internet connection at the time of the 
launch, you will be prompted for a network configuration dialog box, 
where you can configure proxies etc. 

Figure 114: Preferences 
- How things work - 
Update 
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 Hide the update interface until a new version is available. If the 
option above is enabled, you will see a progress dialog box during the 
check for new version. By enabling this option, you can hide the 
progress dialog box, and thus make the check for new version 
completely hidden. 
 
If a new version is available, you will still see all the dialogs from this 
point on. 

Frequency: 

 Check every n days. You can select an check interval in days. Note 
that this is calendar days and not work days. The default value is 10 
days.  

 Check very N times the program is run. This option will count how 
many times you run your program before checking for a new version. 
The default value is 100 times. 

What happens when a new version is present ? 

First of all, you will always see a dialog box, informing you about the 
further process. You can abort the process at any time! 

The "updater" will automatically download the new version. 

The installer of the new version will shut down the current running 
version of List Fields. List Fields can't be running at the same time as an 
update, due to locked application files. The installer will install the new 
version. 

You will typically have to restart List Fields yourself. 

Why is it important to be updated ? The updates contain fixes for known 
problems found in earlier versions. The newer versions will therefore 
presumably be more stable and have less problems. In addition, the newer 
versions might also contain new features or new way of doing things. 
Hopefully you want those!! 
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How things look 
The preferences pages in this section define how different things in List 
Fields look. You can control the fonts, colors and skins of the 
applications.  
 

General Preferences 

 

List Fields contain a possibility to use skins to change the looks of the 
application. This version of List Fields only have one skin, namely the 
Aqua skin, looking much like Macintosh operating systems. Future 
versions might be able to use more skins, which will be downloadable 
from the List Fields homepage http://www.listfields.com . 

If you un-select the Use Aqua-skin, List Fields will behave just like any 
other Windows application. 

Note that you must restart List Fields in order to see the effect of your 
choice. 
 

Figure 115: Preferences 
- How things look - 
General 
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Field List Area Preferences 

You can control how List Fields displays it's fields and values in the 
Field List Area from this dialog box: 

 

Font used in the field area: 

 Use system font and size. If this option is enabled, List Fields will use 
the standard system font and size for it's display. This is the default 
option, and also the fastest. 
 
If this option is de-selected, the fields Font and Size will be enabled. 
Select a font and a size from the drop down lists. Please note that 
fonts larger than 16 points tend to be messy in List Fields. 

 Color of "Fields"-columns. You can change both the Text 
(foreground) and Background color. Note that you can revert back to 
original default colors by pressing the Reset colors... button. This 
button will ask for confirmation before it executes! 

 Color of "Documents"-columns. Also here you can change the text- 
and background colors. The Reset colors button also revert these 
colors 

What is Fields- and Documents columns ?!? 

When you change the colors in this preferences page, List Fields refer to 
Fields- and Document colors. See this screenshot: 

Figure 116: Preferences 
- How things look - Field 
List Area 



 

 List Fields Operation 135 
 

 

The fields in the red box are the Fields columns, while the blue box 
covers the Document columns 

You can Apply the colors at any time 

When you have selected a font, size and any colors,you might test them 
out instantly. Press the Apply button to see your choices in effect! Don't 
like it ?!? Press Reset colors again ... 

Reset windows placements 

The Reset windows placements button will revert all window positions in 
List Fields back to original state. This feature is included to make you 
able to come back to the original state, if you have lost track of where all 
the windows are. In addition, List Fields sometimes experience small 
problems with window positions. A press on this button remedy that 
problem. All layout files (see "List Fields saves all layout changes" on 
page 150) will also be removed. 

The button will ask for confirmation before it executes! 
 

Advanced 
Preference pages in this section typically cover more advanced settings in 
List Fields. 
 

Figure 117: Field List 
Area - The Bands 



 

136 List Fields User's Guide 
 

DXL Preferences 

In the Advanced section of the Preferences dialog box, you find this page, 
DXL. DXL is an abbreviation for Domino XML, where XML again is 
another abbreviation for eXtensible Markup Language. In short, DXL is 
the XML variant for describing Domino data. 

List Fields use DXL to parse Domino information during High Quality 
Rendering (see "High Quality Rendering of richtext" on page 64) (HQR). 

 

The DXL processor in Lotus Notes can be quite slow, especially if the 
Notes document contain large images or attachments. Since it try to 
decode each one of them into Base64-code, the DXL process itself make 
take a while. 

In order to speed up the user experience in List Fields, data from Domino 
is parsed in several stages. The first stage is to get a plain text 
representation of the content. This process is normally very quick and 
will therefore quickly show text data in List Fields. The second stage is to 
render richtext content with better quality, so called High Quality 
Rendering. This process involve DXL to parse attachments and images.  

If you experience slow results in List Fields, the reason might therefore 
be that the document contain large attachments or images, and that DXL 
takes a long time to process them.  

To avoid this slow processing, you might set some thresholds for the 
High Quality Rendering.  

Figure 118: Preferences 
- Advanced - DXL 
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 Only process DXL when attachments are within limits. This option 
control whether all other options are activated or not. When disabled, 
as the default setting are, List Fields will process any document with 
DXL, and thus be slow. When enabled, you can set the threshold size 
in kiloBytes 

 Size in kB. The threshold size in kiloBytes. In our experience DXL 
has trouble when attachments exceeds 1 MB, so try to keep the 
threshold below that. 

 The limit is for all attachments combined. Select this option to set a 
total threshold for all attachments combined. For example, if the 
threshold is set to 1024 kB, and you have a document with 5 
attachments, each at 250 kB, this threshold will stop DXL processing 
since the total size of attachments is 1250 kB. 

 The limit is per attachment. Or, select this option if you want to have 
a maximum size per attachment. If we have the same example as 
above, List Fields will process the document normally with DXL, 
since none of the individual attachments exceeds 1024 kB. 

Note that you can abort List Fields at any time, even if the DXL 
processing hasn't finished. List Fields is a true multitasking application, 
and you can at all times operate the user interface, even if hefty 
processing happens in the background! 
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Replication or Save 
conflicts 

List Fields can be used to aid resolving of replication or save conflicts. If 
a replication or save conflict occur, you will often see them as so-called 
diamond rows (due to the black diamond icon at the very left) with the 
text Replication or Save conflict. Below you see such a document in a 
view 

 

If you have multiple replication or save conflicts, they may look like this: 

 

Some databases may also contain special views displaying only 
replication conflicts, in order to keep the other main views clear from 
conflict documents. The screenshot above has grouped the replication 
conflicts after their Notes Form-name, and thus you don't see all 
participants in the conflict. 

 
 

Figure 119: Replication 
Conflict as often seen in 
a view 

Figure 120: Multiple 
replication conflicts 
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What is replication ? 
In order to understand why a replication conflict occurs, we have to 
understand replication itself. 

Lotus Notes allows databases to synchronize between different machines. 
This means that each machine have a synchronized copy of a database 
stored locally. The process of synchronizing the databases is called 
replication. There are many benefits from this capability: 

 Users can work off-line with databases, such as with their own mail 
database. Even if the user doesn't have connection with a network or 
central Notes server, the user can easily continue to work with his 
mail, such as creating new mail, editing mail, replying to mail or 
deleting or reorganize mail. All changes done on the local database 
will be synchronized to the central copy on the server as soon as the 
user has connection with the server. Likewise will any changes done 
on the central copy synchronize "down" to the local copy.  

 The capability to replicate databases goes for any database that the 
user has at least read access to! 

 Servers can also synchronize databases between themselves. The 
main benefit of this is to use network resources efficient. The 
replication process is very quick and efficient compared to using the 
database on-line. If you have dial-up telephone lines, ISDN or any 
other slow network connection, replication may be a very efficient 
way to synchronize data. 
 
In addition, replication also fail-safes the database. If the central 
server in a company goes down, the database may still be available on 
any of the spoke-servers. This helps keeping the up-time of the 
database at a maximum rate! 
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What is a Replication Conflict ? 
Let's explain replication conflicts by using an example.  

A customer contact database exist on a central Domino server at the head 
quarters of a company.  

An employee has made a local replica copy of this database on his own 
computer. This enables the user to work with customer contacts while 
he's off-line. In our example, the user replicate the database and goes on a 
short business trip. 

On the trip, our user discover that the telephone number of customer 
Voith's CODE is wrong, so he corrects it.  

At the same time, the same error is discovered at the head quarters by one 
of the secretaries. The secretary also update the telephone number - now 
in the central customer contact database. 

If we take a birds view, we now see that the telephone number of Voith's 
CODE has been updated in both the users local replica copy of the 
customer contacts database - AND - in the central customer contact 
database by the secretary. 

When the user comes back to the head quarters, he replicates the 
customer contact database. This operation involves sending all local 
changes to the central database, and vise versa, receiving all changes 
done to the central database while he was away.  

Since the exact same document now has been updated in both replica 
copies, Domino can't really decide which update is the most important. Is 
the change that the employee did on his local replica copy the correct 
change ? Or is the change that the secretary did on the central replica 
copy the correct one ?  

Domino will instead create a replication conflict! This means that both 
versions of the change will be saved, and no information is lost.  

Domino will decide which of the two changes that are most recent, and 
make that document the "winner" of the replication conflict. The other 
document will be made a direct response-to-response document of the 
winner, and thus be the "looser". Since it is a real response document, it 
will often show up in a view as an indented response document, such as 
in the sample below: 
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Note how the Replication or Save conflict-document is indented below 
it's parent. 

If you open the parent document, you will see the the winner-version of 
the replication conflict, and if you open the document with the title 
Replication or Save conflict, you will see the looser-version of the 
document.  

 
 

How to manually resolve replication conflicts 
Traditionally it's up to you, to decide what caused the replication 
conflict.You would normally open both documents, and try to figure out 
which fields contains the differences. When the fields has been identified, 
you must decide which of the versions to keep. Refer to the example in 
the previous section; which of the telephone numbers is correct ? When 
all this is done, you would update the winner with the correct data, and 
finally delete the looser documents. The conflict is solved! 

The benefit of having replication conflicts is that no data is lost, while the 
challenge is to resolve the conflicts later. 

Remember that Domino has the possibility to have automatic resolving of 
replication conflicts enabled. This feature enable Domino to 
automatically resolve conflicts if the changes has all been done to 
different fields. Refer to the example in the above section; If the 
employee changed the postal address, while the secretary changed the 
telephone number, Domino would be able to merge all changes into one 
document, since the changes was done to different fields. 
 

Figure 121: Replication 
Conflict as often seen in 
a view 
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What is the "Save" part in Replication or Save conflict ? 
In all the sections above, you have seen Replication or Save conflict. So 
far we have only described replication conflicts.What is then a save 
conflict ? Basically it's the exact same thing, and Domino treat a save 
conflict in the exact same manner as a replication conflict. How can a 
save conflict occur ? 

A save conflict would occur if multiple users can edit the exact same 
document at the same time on one replica copy of the database.  

An example illuminate this concept: We have a customer contact 
database on a Domino server, and the database allow several users to edit 
the contact information. 

Secretary A opens the customer document of Voith's CODE at 09:45, and 
modifies the telephone number. 

Another employee opens the same customer document at 09:50. The 
document is already opened by secretary A, but this employee can't detect 
that. This employee updates the postal address of Voith's CODE 

Secretary A saves the customer document at 09:55. The customer 
document is still open in edit mode at the employee's machine, but 
neither the secretary nor Domino detects this at this moment. 

The employee saves the customer document at 10:00. Domino will detect 
that the document has already been saved while this employee was 
editing the document, and Domino will inform the user that this 
document will be created as a save conflict if he proceeds with the save-
operation: 

 

The reason for this behaviour is that Domino can't decide which of the 
updates to keep. The changes done by the secretary could be just as 
important as the changes done by the employee, even if it was saved first. 

Again we see how Domino preserves data, and ensure that no data is lost. 
And again we see that we have to manually resolve a conflict. 

 
 

Figure 122: Save 
Conflict Warning 
Dialogbox 
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First of all, List Fields will automatically detect if one of the selected 
documents are a so-called member of a replication conflict. You will see 
this dialog if this is the case: 

 

The dialog box is divided into two parts, an informal part and a select one 
of the following actions-part. 

 

 

 
 

Information about replication conflicts - and the current 
status of the selected document 

Just below the information you can see if the currently selected document 
is a "winner" or "looser" in this conflict. If it is a looser, it means that the 
selected document is the response document with the Replication or Save 
conflict-text. If it is a winner, it means it is the parent document having 
looser documents as responses. 
 

Figure 123: Replication- 
or save conflict detected 
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Select one of the following actions 

List Fields let you decide which document or documents to open - and 
this is one of the cooler features of List Fields! 

 Open only selected document. Even if List Fields has decided that the 
current document is participating in a replication conflict, you may 
choose to open only the selected document. Select this option if the 
replication conflict really doesn't care. 

 Open the winner and all appurtenant replication conflict loosers. If 
the currently selected document is a winner- or looser, you can open 
all participating documents in the replication conflict.This is handy if 
you have multiple replication conflict documents! 

 Open the looser and it's appurtenant winner document. This option is 
available if the currently selected document is a looser. It will open 
the immediate parent winner document in addition. It will not open 
any sibling looser document! 

This ability to open replication conflict participant documents makes it 
easy to both find the fields with differences, and where the differences in 
those fields are! 

If you don't want to have this question every time you encounter a 
replication conflict participant document, then you may choose to let List 
Fields decide for you the standard action by activating Don't ask again, 
and use defaul action without asking me. 
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Aid resolving the conflict 

List Fields has two small tools to aid you when resolving replication- or 
save conflicts. Right-click on the document-column headers (the column 
headers with the names Document 01 (Winner), Document 02 (Looser) 
etc.)to see the document context menu: 

 

The menu items are: 

 Show this document in Notes. By selecting this menu item you will 
launch the currently selected document in Lotus Notes. The idea is 
that you might operate List Fields from a special view (read more 
about such views in Replication Conflicts (see "Replication or Save 
conflicts" on page 139)) showing only the conflict-documents and not 
the complete conflict-hierarchy. It can sometimes be handy to see the 
original document before acting on it! 

 Set this document as "Replication- or Save conflict" winner. By 
selecting this menu item, you will force this document to be the 
winner of the conflict. All other participating conflict-documents may 
be deleted. As for any other changes in List Fields, several change 
log (on page 100) entries will be created, and no actual conflict 
resolving will be processed until you explicitly confirm (see "Save 
you changes" on page 102) List Fields to do so. 
 
Below you see a screenshot of the change log after this menu item has 
been selected: 
 

 
 
Note that List Fields split the conflict resolving into several entries, 
so you freely can choose exactly what to do. 
 
Remember that List Fields will back up (see "Backup and work 
database created" on page 59) the original documents before any 
changes are processed. 

 

Figure 124: Document 
Context Menu 
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How to avoid replication or save conflicts 
Replication or Save conflicts occur when the same document has been 
edited multiple places at the same time.  

Avoiding replication or save conflicts can be a daunting task, due to the 
disconnected nature of Notes databases. We divide the task of avoiding 
such conflicts in two: 

1 If a database is placed only on one server, and all users access the 
database via the network, you can implement a document locking 
logic. If a document is about to be opened for editing, the locking 
logic will first check if the document already has been locked (ie. 
someone else is editing the document right now). If the locking logic 
determine that the document isn't locked, it will allow the current user 
to open the document in edit mode. At the same time the locking 
logic activates a lock on the document, for the current user. This lock 
will prevent any other user from editing the document now. If they 
tried, they would be informed that the document is currently being 
edited by the current user. 
 
When the current user is finished editing the document, and close the 
document, the current document lock will be removed, and thus 
allowing anyone else to edit the document again. 
 
This logic works fine as long as everybody is working on the exact 
same database, and you will avoid Save conflicts, since nobody can 
save the same document at the same time. 
 

2 If the database is replicated, either to users local workstation or to 
other servers, the locking logic above wouldn't work. The replica 
copies of the database is not aware of each other, and they may not 
even be on-line. If a user or server edit the same document now, a 
replication conflict would be the result. 
 
Basically it's hard to avoid replication conflicts if too many people or 
servers has access to the document. One possible way to control this 
scenario is to have different Readers- and Authors access to the 
documents, and ensure that the ACL is held consistent on the replica 
copies. The idea is to keep the number of potential simultaneous 
authors to a document to a minimum. 
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Technically the database designer can also help avoiding replication 
conflicts: 

 If the designer enable Conflict Action on the Form Properties, as 
below: 
 

 
 
By default this property isn't set. In Notes 6 you have several options 
on how to react if a conflict occur. 
 
Remember what merging conflicts do; Domino will only resolve 
conflicts automatically if the differences are in different fields. 
 

 The designer can enable versioning so that each document save create 
a new version. 
 

None of the techniques above will eradicate the probability for replication 
conflicts completely. The designer therefore has to balance the features 
available with the probability of conflicts. 
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Stopping List Fields 

How to stop List Fields 
List Fields operates like a traditional Windows application, and you can 
stop it several ways: 

 Select the menu File -> Exit. 
 Click the X-button in the upper right corner 
 Press the key combination ALT+F4 

 

Do you want to save your changes 
If you have active change log entries in your Change Log (on page 100), 
List Fields will ask you if you want to save these changes or not: 

 

If you acknowledge this message, List Fields attempt to save your 
changes. Note that you will see a Save Error Report (see "Save Errors" 
on page 103) if anything goes wrong during the save operation! 
 

Figure 125: Do you want 
to save your changes 
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List Fields saves all layout changes 
When List Fields terminates, it will save all changes done to the Field 
List Area. All column grouping (see "Group on any column" on page 
92), sorting (see "Sort any column in any direction - even multiple 
columns at the same time" on page 86), reordering (see "Reorder 
columns in any order" on page 88) and filtering (see "Filter any column 
to show only what you want" on page 89) will be preserved.  

When you exit List Fields for the first time, List Fields will ask you 
where to store the so-called layout files. You will see this dialog box: 

 

List Fields has by default chosen your personal directory. You can select 
any other directory, and List Fields will remember the directory. You can 
also change the layout directory at any time from the Field List Area 
Preferences (see "Field List Area Preferences" on page 134). 

 
 

Figure 126: Save Field 
List Area Layout 
Question 
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The NotesPeek application 
For years, NotesPeek has been the de facto standard application to dive 
into the inner details of Notes databases. The name with the suffix "peek" 
reminiscence the old days when programmers frequently had to read 
content at memory locations by "peeking", and writing to memory 
locations with "poking". In addition the icon x-raying the "Notes-folks" 
identify the purpose of NotesPeek quite good: 

NotesPeek was written by Ned Batchelder, a former Lotus 
employee. The user interface is clean and intuitive using the treelist to 
navigate in databases, documents and fields. The content is shown in the 
main area to the right. Below you see a screenshot of NotesPeek. 

 

You will find all sort of information here, and as you see from the 
screenshot above, you can really dive into richtext to see how the CD 
records are sequenced and what they contain.  

How does List Fields interact with NotesPeek ? 

List Fields has the ability to launch NotesPeek and make it open the 
currently selected document in List Fields. This makes it very quick and 
easy to dive into the document with NotesPeek if you don't find the 
information you're looking for in List Fields.  

You launch NotesPeek from the Information Area toolbar by clicking on 
the NotesPeek icon. 

The first time you launch NotesPeek, List Fields want you to specify 
where your NotesPeek application is located. You do this from the dialog 
box shown below: 

Figure 127: NotesPeek 
main screen 
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The filename of NotesPeek is Ntspk32.exe. Press the ...-button to bring up 
a find-a-file dialog box. 

More information on NotesPeek 

Voith's CODE encourage you to check out NotesPeek on your own, and 
you should check out this Lotus Developer Domain article http://www-
10.lotus.com/ldd/today.nsf/0db661345413ad1d852567ba006bb090/23d24
ec8a4c568e9852566320058521d?OpenDocument. 

Unfortunately NotesPeek isn't a "directly supported tool" by IBM, and 
even if the Lotus Business Partner Community has heard some beeps 
about a new version for Notes and Domino 6, nothing has been 
committed nor promised by IBM. 
 

Figure 128: Where is 
NotesPeek located 
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Solving problems - debugging 
Voith's CODE sincerely tries to make applications as robust as possible. 
However, there will probably be times when List Fields fail, or even 
worse - crash!  

Determining the cause of a problem may be very hard, since there are 
some many possibilities! Think of all the different kinds of Notes 
documents you work with every day!  

In order to determine the cause of the problem or crash, often dubbed 
debugging, various techniques have been implemented in different 
applications. Some applications implement logging, where intermediate 
results and data are recorded. By examining the log post operation, the 
application developers may be able to spot the problem. Voith's CODE 
has also used this approach in other applications, with mixed results.  

List Fields implement another technique. It collect the document or 
documents that causes the problem into a separate Notes database, along 
with various system information. The database containing the "problem 
document" may be sent to Voith's CODE for analysis. Voith's CODE will 
run List Fields in debug-mode on the problem documents. This technique 
will often reveal the exact cause of the problem, enabling Voith's CODE 
to fix the problem more quickly. 
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How to start List Fields in debug-mode ? 

Hold the SHIFT button down when you launch List Fields. After a short 
while you will see the the Information about debugging dialog box. 

 

From this dialog box you control what to include in the so-called List 
Fields Debug Session Database.  

The debug database database is a normal Lotus Notes database which 
contain: 

 The document(s) you are about to work with in List Fields.  
 A List Fields Information document, with information about your 

List Fields installation 
 Optional System Information document, see more about this 

document below 
 Optional Lotus Notes Information document, see more about this 

document below 

These are the areas to control in this dialog box: 

Figure 129: Information 
abot debugging 
Dialogbox 
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1 The information area. If this is the first time you try to debug List 
Fields, please read the short description here. It contains the short-
version of this text! 

2 Lotus Notes database filename. You must give the debug database a 
filename. By default List Fields will calculate a filename based upon 
the date and time right now, and place the default filename in your 
Notes data directory (on page 36). The last part of the filename is a 
counter if you have multiple debug databases on the same date. Click 
the ...-button to select another directory.  
 
List Fields will remember the directory you put the debug databases 
into, so you can for example create a separate debug database 
directory below your standard Notes data directory.  

3 Include system information. If this option is enabled, a separate 
System Information document will be created in the debug database, 
containing different information about your system, operating system, 
LAN an so forth. Please read this (see "System Information" on page 
159) topic for details about the content of the system information 
document. 

4 Include Lotus Notes information. If this option is enabled, a separate 
Lotus Notes Information document will be created in the debug 
database. This document will in essence contain the content of your 
NOTES.INI file. Please read this (see "Lotus Notes information" on 
page 163) topic for details about the content in this document 

5 EMail debug database as a zipfile to Voith's CODE for analysis. The 
debug database won't be mailed anywhere by default, so you have to 
manually enable this support.  If enabled, List Fields will zip the 
debug database and automatically mail it to Voith's CODE as soon as 
the database has been finalized (all documents copied and all 
information documents created). 
 
You have the possibility to add a Subject and Body to the e-mail. 
Please give a short description of the problem for later reference. 
 

6 Delete database after sending e-mail. If the EMail support is enabled, 
you also have the ability to cleanup after the database has been sent. 
Use this feature if you don't want debug database lying around on 
your file system. 

7 Copy Notes filename to clipboard. You might want to work with the 
debug database after List Fields has finished it. You can therefore 
copy it to the clipboard, so you can keep record of it later. 
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When you have set al the options and are ready to go, press the OK, start 
with debugging! button. Since the creation of the debug database might 
take a while, you will be reminded about this in the message I003 (see 
"I003: List Fields Debug Session database is about to be created" on page 
169). You can turn this message off if you want to. As soon as the 
database creation start, you can see the progress in the debug dialog box. 

As soon as the debug database has been created, List Fields will copy the 
document(s) to the debug database. If will also, based upon your 
selections above, create the information documents. When these 
operations has finished, the database will either be; 

 ...E-mailed automatically to Voith's CODE for analysis, if this option 
was selected 

 ...or you will be prompted the informal message I004 (see "I004: List 
Fields Debug Session database created" on page 170), which also 
contains a link to the database itself. 

 

If you have a crash or hang with List Fields it would be most valuable for 
List Fields to fix the problem. As described here (see "Solving problems 
- debugging" on page 155), this approach has proved most successful for 
bug-hunting ever. Voith's CODE therefore hopes you will take the time to 
send the debug database for analysis. 
 

How to control what information to include ? 

From the main debugging dialog box you can control whether to include 
System- and Lotus Notes Information or not. If you choose to include 
such information, List Fields will by default include many details about 
your system and Lotus Notes installation. 

For many reasons, you might not want to expose some of this information 
to Voith's CODE. We fully respect that, and have therefore created a 
system which fully let you control what information to expose or not. 

You may control what goes in the System- and Lotus Notes Information 
documents buy adding keywords to a registry entry. In the subsequent 
topics you will see complete lists over all available keywords to exclude. 

How to exclude keywords ? 

1 Open the registry with a registry tool such as REGEDIT or 
REGEDT32. Remember, exercise extreme caution when modifying 
the registry! 

2 Navigate to the HKEY_CURRENT_USER\SOFTWARE\Voith's CODE/List 
Fields\Settings\Doer\Dialog\Debug. 

3 Modify (or add a new string value keyword if entry isn't found) the 
following keywords: 
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1. SYSExcludeKeywords. This keyword contains a comma-separated 
list of keywords to exclude in the System Information document. 
See here (see "System Information" on page 159) for a complete 
list of keywords. 

2. LNExcludeKeywords. This keyword contains a comma-separated 
list of keywords directly from your Notes.ini file. Check out your 
Notes.ini file and add any of the existing keywords. 

4 Remember to separate the values with commas.  

 

Below you see a Regedit sample screenshot: 

 

Notice how the three System Information keywords Total RAM, IP 
Address and CPU ID are separated with a comma. 
 

System Information 
You can control the following keywords in the System Information 
document 

Keyword Description 
Total RAM How much RAM do your computer have. 

Typical ouput is: 

Installed RAM: 511MB 

Memory Available: 129824KB 

Precent of used RAM: 75% 

Free RAM How much RAM are free on your system ? 
Output are measured in percent. 

 

User Name Your logon User Name on your machine. This 
is typically your name, shortname or even 
computer name, see below. 

Computer Name Your machine name as it is known to your 
network 

Figure 130: How to add 
a new 'exclude keyword' 
entry in registry 
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IP Address Your local IP address on the typical dot 
notation x.x.x.x 

Number of CPUs How many CPUs does your machine have ? 

CPU Speed How fast are your CPUs, measured in MHz ? 

CPU ID The ID of your CPU. Typical output: 

Vendor ID: Intel Corporation 

CPU Type ID: 0 

Family ID: 6 

Model ID: 11 

Stepping Code: 1 

Brand ID: Pentium® III (0.13 µm)
With 256 Or 512 KB On-Die L2 
Cache 

CPU Vendor ID The vendor ID of your CPU. This information 
is also included in the CPU ID keyword above,  
so this keyword can be regarded as a trimmed 
down version of CPU ID. Typical output: 

Vendor ID: Intel Corporation 

Brand ID: Pentium® III (0.13 µm)
With 256 Or 512 KB On-Die L2 
Cache  

Resolution The screen resolution. Typical output: 

Screen resolution: 1600x1200 

Width: 1600 pixels 

Height: 1200 pixels 

Pixel Depth Screen resolution, color depth and screen 
refresh rate. Typical output: 

Color depth: 32 Bits per pixel. 

Pixel Width: 1600 

Pixel Height: 1200 

Refresh frequency: 60 Hz 

OS The root directory of your Operating System 
Files. Typically C:\WINDOWS 

System The directory of the system files of your 
Operating System. Typically 
C:\WINDOWS\System32 

Personal Your personal directory. This is equivalent with 
My Documents below. Typical output: 

C:\Documents and Settings\username\My 
Documents.  

My Documents Your virtual personal directory. On older 
systems this is equivalent to Personal above. 

Program Files The root directory of your installed programs, 
typically C:\Program Files. 
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Startup The folder contains typically links to programs 
that will be launched at OS startup. I typically 
contains: C:\Documents and 
Settings\username\Start 
Menu\Programs\Startup 

Desktop Contain the links, applications and other 
content shown on your desktop. Typically 
C:\Documents and Settings\username\Desktop 

Cookies The folder acts as a repository for internet 
explorer cookies. Typically C:\Documents and 
Settings\username\Cookies 

Start Menu The folder contain links and applications shown 
in your Startup program group. Typically 
C:\Documents and Settings\username\Start 
Menu\Programs\Startup  

Favorites The file system directory that serves as a 
common repository for the user's favorite items. 
A typical path is C:\Documents and 
Settings\username\Favorites 

Fonts A virtual folder containing fonts. A typical path 
is C:\Windows\Fonts 

Internet Cache The file system directory that serves as a 
common repository for temporary Internet files. 
A typical path is C:\Documents and 
Settings\username\Local Settings\Temporary 
Internet Files 

Local Application The file system directory that serves as a data 
repository for local (nonroaming) applications. 
A typical path is C:\Documents and 
Settings\username\Local Settings\Application 
Data 

Program Group The file system directory that contains the 
user's program groups (which are themselves 
file system directories). A typical path is 
C:\Documents and Settings\username\Start 
Menu\Programs 

Recent The file system directory that contains shortcuts 
to the user's most recently used documents. A 
typical path is C:\Documents and 
Settings\username\My Recent Documents. 

Send To The file system directory that contains Send To 
menu items. A typical path is C:\Documents 
and Settings\username\SendTo 

Templates The file system directory that serves as a 
common repository for document templates. A 
typical path is C:\Documents and 
Settings\username\Templates 

Administrative Tools The file system directory that is used to store 
administrative tools for an individual user. 
Typically C:\Documents and 
Settings\username\Start 
Menu\Programs\Administrative Tools 
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History The file system directory that serves as a 
common repository for Internet history items. 
Typically  C:\Documents and 
Settings\username\Local Settings\History 

NetHood A file system directory containing the link 
objects that may exist in the My Network 
Places virtual folder. A typical path is 
C:\Documents and Settings\username\NetHood. 

Profile The user's profile folder. A typical path is 
C:\Documents and Settings\username. 

Common Startup The file system directory that contains the 
programs that appear in the Startup folder for 
all users. A typical path is C:\Documents and 
Settings\All Users\Start 
Menu\Programs\Startup. Valid only for 
Windows NT systems. 

Common Programs 
Group 

The file system directory that contains the 
directories for the common program groups that 
appear on the Start menu for all users. A typical 
path is C:\Documents and Settings\All 
Users\Start Menu\Programs. Valid only for 
Windows NT systems. 

Common Desktop The file system directory that contains files and 
folders that appear on the desktop for all users. 
A typical path is C:\Documents and Settings\All 
Users\Desktop. Valid only for Windows NT 
systems 

Common Favorites The file system directory that serves as a 
common repository for favorite items common 
to all users. Valid only for Windows NT 
systems. A typical path is C:\Documents and 
Settings\All Users\Favorites 

Common StartMenu The file system directory that contains the 
programs and folders that appear on the Start 
menu for all users. A typical path is 
C:\Documents and Settings\All Users\Start 
Menu. Valid only for Windows NT systems 

Common Administrative 
Tools 

The file system directory containing 
administrative tools for all users of the 
computer. A typical path is C:\Documents and 
Settings\All Users\Start 
Menu\Programs\Administrative Tools 

Common Application 
Data 

The file system directory containing application 
data for all users. A typical path is 
C:\Documents and Settings\All 
Users\Application Data 

Common Documents The file system directory that contains 
documents that are common to all users. A 
typical paths is C:\Documents and Settings\All 
Users\Documents. Valid for Windows NT 
systems and Microsoft Windows® 95 and 
Windows 98 systems with Shfolder.dll 
installed. 
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Lotus Notes information 
List Fields will by default list every keyword in your Notes.ini file. You 
can specify any keyword from the Notes.ini you want to exclude! 
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Messages 
This topic describe the messages you might occur in List Fields. 
 

E000: Lotus Notes client is not running! 

List Fields reads Notes documents, and the Lotus Notes client has to be 
active in order to use List Fields.  

This cause of this error is that the Notes client is not running. A probable 
cause is you started List Fields without using the Action-menu (see "How 
to start List Fields via the Action menu" on page 45), and instead 
launched List Fields from the operating system (see "How to start List 
Fields from the operating system" on page 46) via an icon or system wide 
short-cut.  

Restart Lotus Notes and try again! 

 
 

E001: The Lotus Domino Designer is on top 

If you launch List Fields via the Actions-menu (see "How to start List 
Fields via the Action menu" on page 45), you will automatically have the 
Notes client "on top", and this error will never appear! 

But, if you launch List Fields from the operating system (see "How to 
start List Fields from the operating system" on page 46), such as via an 
icon or short-cut, List Fields must have the Notes client "on top of" other 
Notes clients, such as Lotus Domino Designer or Domino Administrator. 

Right now the Lotus Domino Designer is on top! Ensure that the ordinary 
Notes client is on top and try again.  
 

E002: The Domino Administrator is on top 

If you launch List Fields via the Actions-menu (see "How to start List 
Fields via the Action menu" on page 45), you will automatically have the 
Notes client "on top", and this error will never appear! 

But, if you launch List Fields from the operating system (see "How to 
start List Fields from the operating system" on page 46), such as via an 
icon or short-cut, List Fields must have the Notes client "on top of" other 
Notes clients, such as Domino Administrator or Lotus Domino Designer. 

Right now the Domino Administrator is on top! Ensure that the ordinary 
Notes client is on top and try again.  
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E003: Is List Fields installed correctly ? 

When List Fields start up, it will check the presence of certain registry 
settings, and if these settings aren't there, this message will pop up. The 
setting that is required at this stage is the Version-string. Read more about 
it's exact location here (see "Necessary modifications in the Registry" on 
page 37). 

The only option is to acknowledge the message and watch List Fields 
abort operation completely. Inspect your installation and re-install List 
Fields if necessary. 

 
 

E004: Can't determine which document to work with 

This error occur if List Fields can't decide which document to work with. 
Most likely has List Fields been started without using the Action-menu 
(see "How to start List Fields ?" on page 45) in Lotus Notes. 

Unfortunately List Fields can't continue, and will terminate. 
 

E005: The Notes database can't be opened 

List Fields can't open the database! This indicate a serious error, either 
with the database itself, the network connection or the database Access 
Control (ACL).  

Since List Fields can't open the database, it's not much left for List Fields 
to do, so it will unfortunately terminate 
 

E006: The Notes document hasn't been saved yet! 

You launched List Fields on a document that hasn't been saved yet! 

List Fields can only read the Notes documents after they have been saved. 
Read much more about so-called front-end and back-end documents 
here. 

The only thing to do right now is to terminate List Fields and save the 
Notes document before you launch List Fields again. 

Tip: Use the Notes short-cut CTRL+S to save the document quickly! 
 

E007: The document couldn't be read! 

This error typically occur if you try to launch List Fields on a category- 
or total row in a Notes view. You will also see the error message returned 
from the Notes API in this error. 
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E008: Notes.ini could not be found in any PATH directories 

The main configuration file for Lotus Notes is named NOTES.INI. This 
file contains many configuration parameters for Lotus Notes and any 
Notes API based application must be able to locate this file in order to 
function properly. If you install Lotus Notes via it's standard installation 
program, NOTES.INI will be placed in the Notes program directory (on 
page 34).  

The installation program for List Fields automatically ensure that the 
NOTES.INI is found and that the directory is specified in the PATH 
environment variable on your computer. 

List Fields has however detected that the NOTES.INI file no longer is 
available in any of the PATH directories. 

This may indicate that you have multiple Notes clients installed at the 
same computer. A traditional trick to make this happen, is to have 
multiple NOTES.INIs, one for each installation. Each Notes client is 
started with the =<path and filename of NOTES.INI> 
parameter, and thus have their own INI file. In such scenarios, the 
problem can be avoided if you copy the currently selected INI file to a 
directory specified in the PATH variable, such as the Notes program 
directory. 

Please refer to How to do a manual installation (on page 33) chapter to 
learn more about manual installation of List Fields 

 
 

W001: Have you saved the Notes document ? 

List Fields can only access the back-end document! This implies that a 
potential challenge may arise if you launch List Fields on a document in 
edit mode which haven't been saved immediately before List Fields-
launch. List Fields will read the back-end document and show those 
values to you, and you might not see the most current values!  

Read much more about front-end and back-end documents here! 
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W002: The size of all attachments combined is too large for 
high quality rendering 

List Fields attempt to do a so-called high quality rendering of the rich 
text fields in the document. This process is done by extracting the content 
of the rich text field with DXL. (Domino XML Language). If the 
document contain large binary objects such as file attachments, images or 
OLE attachments, this process will be very slow and potentially hinder 
other functionality in List Fields.  

You receive this message when the combined size of all attachments 
(files, images, OLE attachments etc) exceed the specified size threshold 
in List Fields.  

You may choose to experiment with the size threshold, since the speed of 
your computer may impact on how much data DXL can process. In 
addition, people are different regarding patience, and you may be willing 
to wait a little longer in order to get high quality rendering ?!? You can 
manipulate the size threshold here (see "DXL Preferences" on page 136). 
 

W003: The size of one of the attachments is too large for 
quality rendering 

You receive this message when the size of one of the attachments exceed 
the specified size threshold in List Fields.  

The explanation is otherwise similar to the W002-message (see "W002: 
The size of all attachments combined is too large for high quality 
rendering" on page 168). 
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W004: Can't save or open attachments right now! 

List Fields attempt to do a so-called high quality rendering of the rich 
text fields in the selected Notes documents. This is done with the Domino 
XML Language (DXL). Unfortunately, it's not possible to detach any 
attachments during DXL processing. 

If the document contain large- and/or many attachments, DXL may be 
occupied with data processing when you try to save or open an 
attachment. Unfortunately the Notes C/C++ API won't allow more than 
one active application-thread accessing the Notes database at any given 
time. 

This message informs you about this issue, and you may wait and retry 
the save or open action again later. 

You may also control the so-called size thresholds that List Fields use to 
determine if it should process documents with DXL at all. In other words, 
if the document contains too large- or too many attachments, you may 
hinder List Fields from processing the document with DXL. The 
disadvantage with this option is that you won't be able to see the high 
quality rendering of rich text fields. The advantage is that you may save 
or open your attachments quicker! You can manipulate the size threshold 
(see "DXL Preferences" on page 136) in the Preferences dialog box. 
 

I003: List Fields Debug Session database is about to be 
created 

If you have selected to start List Fields in debug mode (see "Solving 
problems - debugging" on page 155), you will see this message just after 
you have pressed the Ok, continue with debugging button.  

The creation of the List Fields Debug Session Database will take some 
moments (typically 3-5 seconds on a 1 Mhz Pentium processor), and you 
should just know about this. 
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I004: List Fields Debug Session database created 

When you have started List Fields in debug mode (see "Solving problems 
- debugging" on page 155), you will create a List Fields Debug Session 
Database. After the database is created, List Fields will copy the 
document(s) in question and fill in the information controlled from the 
Debug dialog box. When these operations are finished, you might see this 
message, if you have selected not to automatically send this database to 
Voith's CODE. 
 

 

Note that this message contains a hyperlink to the List Fields Debug 
Session Database itself. By clicking this link, you will launch the 
database in the Lotus Notes client. You can then check out the documents 
in question, and see all the information put into the debug database. 
 

Q001: Do you want to save your changes ? 

This question is shown either if you have any active change log entries in 
your change log (on page 100), or you press the Save button in the 
Change Log pane in the Information Area. 
 

Q002: Do you want to delete the currently selected field ? 

You will see this question when you attempt to delete a field (see "Delete 
field" on page 95) in List Fields. 

If you confirm the deletion, a new change log (see "The Change Log" on 
page 124) request will be created. This means that you still can regret the 
delete-action by simply de-selecting the change log entry before saving 
the changes. 

Note that List Fields will delete the field in all the editable documents 
shown in List Fields. You must have author access for the documents in 
order to delete fields. 
 

Figure 131: I004: The 
List Fields Debug 
Session Database has 
been created 
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MIME and 822 Text 
From the Startup preferences page (see "Startup Preferences" on page 
128), you can control the following; If document has MIME, open with 
MIME encoding.  

 
 

Background 

MIME is an abbreviation for Multipurpose Internet Mail Extensions. 
Behind this rather cryptic expression lies an internet standard describing 
how to send messages containing data other than plain text across 
internet. For links to the standards themselves, read this (see "The 
standards" on page 179) topic. 

Back in time, it was only possible to send plain text. MIME was invented 
to allow messages to contain enriched content, such as graphics, HTML, 
sound, video etc. 

A MIME message, as opposed to a plain text message, contain one or 
more parts. Each part has a content type identifier, saying something 
about what the part contains. You have probably stumbled across content 
types such as text/plain, text/html, image/gif, image/jpeg or audio/mpeg. 
A simple e-mail reader can for example only read plain text messages, 
and will automatically choose the part with content type text/plain, while 
a more advanced e-mail reader would choose text/html in order to see the 
mail with more rich experience. One of the cool things with MIME is 
therefore the ability to incorporate different content for different readers. 
One thing to remember, is that imbedded graphics is always stored as 
separate parts, with content-types such as image/gif or image/jpeg. The 
MIME standard define the order of- and how each part should be linked 
together. 

All modern mail clients can read and write (or de- and encode ...) MIME 
messages nowadays, including Lotus Notes. 
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How Lotus Notes support MIME 

The Lotus Notes client will by default try to simplify and hide some of 
the cumbersome MIME details. When you for example open a MIME 
mail, Lotus Notes will automatically distill the MIME parts into normal 
ordinary richtext. You can see this behavior if you follow these steps: 

 Open your mail database, and select a message that looks like an 
internet mail. Don't open the message, just select it. 

 Right-click on the message and select the menu line Document 
Properties from the context menu (alternatively press ALT+ENTER). 

 In the Document Properties, look for several Body fields, such as in 
the example below: 
 

 
 
Note that the Body field is of data type MIME Part. You can also see 
the content-type identifier in the data area. Have a look at the other 
fields as well, and you will see different parts with different data. 
Also look out for fields containing data types RFC822 Text. 

 Open up the mail message, and take a look at the Document 
Properties again. 

The Domino server has something to say ... 

How MIME messages should be treated on your system, can be 
controlled by changing different settings throughout your system. First 
and foremost can the Domino server convert incoming MIME messages 
to Notes richtext before you even see them in your inbox.  

Go to your person document in the public directory (formerly called 
Name and Address book), and look for the mail settings. In Domino 6 the 
part looks like this: 
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Look at the field Format preference for incoming mail. Valid options are;  

 Keep in senders' format. The Domino server won't touch the format 
in the incoming mail at all, and if it is MIME, it will stay MIME. This 
is probably the most flexible option. 

 Prefer MIME. All non-MIME messages will be converted to MIME, 
so you will only see MIME messages in your inbox. 

 Prefers Notes Rich Text. All incoming mail will be converted to 
Notes Rich Text format, and you won't see MIME messages at all. 

In Domino R5 and R4 environments, the option No Preference is 
equivalent to Keep in senders' format. 

And your Lotus Notes client preferences have something to say ... 

You can further instruct your Lotus Notes client to treat MIME. Look at 
the Lotus Notes client Preferences below (select File -> Preferences -> 
User Preferences): 

Figure 132: Setting the 
preferences for incoming 
mail in the person 
document in the NAB 
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You can also control how your Lotus Notes client will send e-mail, and 
this is controlled from the Mail -> Internet page of the same Preferences 
dialog. It looks like this; 

 

The valid options are: 

 HTML only. Your outgoing message will be converted to the most 
rich experience, typically as content type text/html with other parts 
for imbedded graphics, attachments etc, Note that older e-mail reader 
might not be able to read these messages! 

 Plain text only. Ensure you send your mail with content type 
text/plain. All e-mail readers can read your messages. 

 HTML and Plan Text. Create a multi-part MIME message, containing 
both plain text and more rich experience parts. In effect, you will be 
creating a larger outgoing e-mail, that will be readable by almost 
every e-mail reader out there. This is generally the best option, even 
if it creates larger e-mails. 

 Prompt when sending. When you send an internet e-mail, Lotus 
Notes will ask you how to format it with the options above. You can, 
based on your knowledge of the receiver, or more precisely, your 
knowledge of your receivers e-mail client, select the most appropriate 
e-mail format. This will generate the most trimmed e-mail format for 
your receiver. 

Figure 133: Setting some 
MIME preferences in the 
client 

Figure 134: Setting the 
outgoing internet mail 
format 
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The programming interface (API) way of doing it ... 

Via it's APIs, application developers can choose if they wan't MIME 
support or not. This is done by selecting a document mode. 

The first mode, which I nickname easy-mode, hide much of the difficult 
details for the programmer. For example will the raw MIME fields be 
converted into ordinary richtext fields which are simpler to work with.  

The other mode, which I nickname raw-mode, doesn't aid the 
programmer with anything. Now all MIME fields are present, and a 
programmer needs to parse the data very differently compared to easy-
mode. 
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List Fields - in easy-mode 

List Fields will by default operate in easy-mode, and thus automatically 
convert all MIME fields into richtext. This means that you won't see the 
real MIME fields since the programming interface on a low level convert 
the MIME fields into richtext before clients, such as List Fields, can see 
them.  

Below you see how a MIME message looks in the Lotus Notes client: 

 

And now we take a look at this document in List Fields, in easy-mode: Figure 135: How a 
MIME e-mail look in the 
Notes client 
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In the screenshot above the Body field has been selected in the Field List 
Area, and thus it's content are shown in the Output Area. Note that we 
only have one Body field, and that the content obviously is of type 
richtext. Also note that the imbedded images from the MIME message 
are stripped out and replaced with [IMAGE]. Lotus Notes has aided the 
programmer by making it much easier to access the content of the 
message, as opposed to accessing the different MIME parts individually. 
The result is however sometimes not completely satisfactory. 

Also note that you can see the status of the MIME processing by clicking 
on the MIME button in the statusbar: 

 

 
 

Figure 136: A MIME 
message in easy-mode 

Figure 137: The MIME 
status button in the 
statusbar 
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List Fields - in raw mode 

You, as a user, can however instruct List Fields to operate in raw-mode. 
This will make List Fields do the following: 

 Exposing all the MIME fields with all it's data. 
 Emphasize certain fields and data in the MIME fields, making it 

easier to spot the data. 
 Format, colorize  and pretty-print HTML.  

Below, you see a screenshot from List Fields after we have enabled the 
MIME support in List Fields's Startup preferences (on page 128): 

 

Compared to the List Fields screenshot in easy-mode, you now see 
multiple Body fields. Each Body field typically contain a separate MIME 
part, and in the screenshot above we look at the text/html part. 

Notice how List Fields format and colorize the HTML in this part. If you 
want closer look at any part in List Fields, why not copy the content to 
the clipboard (see "Copy to clipboard" on page 62) ? 
 

Figure 138: A MIME 
message with MIME 
parts exposed 
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The standards 

This is only a short-list of the most important standards in the MIME and 
822 Text sphere: 

 RFC 2045 http://www.faqs.org/rfcs/rfc2045.html - Multipurpose 
Internet Mail Extensions (MIME) Part One: Format of Internet 
Message Bodies. 

 RFC 822 http://www.faqs.org/rfcs/rfc822.html - Standard for the 
format of ARPA Internet text messages 
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